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ABOUT THIS GUIDE

This guide describes how to use the Transcend ATM and VLAN Network
Management application.

Introduction

Audience
Description

ig

The ATM and VLAN Management Guide describes the features and
functionalities that are implemented using the ATM and VLAN
Management Tools.

This guide is intended for the Network Administrator who is responsible
for configuring, using and managing ATM and Virtual LANs in a network
that may include a wide range of 3COM equipment as well as equipment
from other manufacturers. It assumes a working knowledge of ATM
Networks and a familiarity with HP OpenView, NNM, Netview or Sunnet
for UNIX.

If the information in the Release Notes shipped with your product differs
from the information in this guide, follow the Release Notes.

How to Use
This Guide

The ATM and VLAN Management User Guide guide is divided into two
parts. Part 1 contains an overview of the application and its
features.General network management principles that apply to the
application and explanations of how the application works are also
described.

Part 2 contains procedural information and describes all the network
management tasks in the ATM and VLAN Management application

Table 1 shows where to find specific information.
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Table 1 Organization of the ATM and VLAN Management User Guide

If you are looking for: Turn to:

A comprehensive description of the basic Part 1- Chapter 1
components and concepts of the ATM and VLAN
Management application

How to configure and launch the ATM and VLAN Part 1 - Chapter 2

Manager

How to use the ATM and VLAN Management Part 1 - Chapter 3
Interface

How to perform network configuration tasks Part 2- Chapter 4
How to perform network modification tasks Part 2- Chapter 5
How to perform network troubleshooting tasks Part 2 - Chapter 6
How to perform network measurement tasks Part 2- Chapter 7
Supported Devices Appendix A
Commonly encountered system problems Appendix B

ATM and VLAN Management Basics Appendix C

Conventions Table 2 and Table 3 list conventions that are used throughout this guide.

Table 2 Notice Icons

Icon Notice Type Alerts you to...

b Information note  Important features or instructions

Caution Risk of personal safety, system damage, or loss
A of data
e Warning Risk of severe personal injury
Table 3 Text Conventions
Convention Description
Syntax The word “syntax”” means you must evaluate the syntax

provided and supply the appropriate values. Placeholders for
values you must supply appear in angle brackets. Example:

Enable RIPIP by using the following syntax:
SETDefaultl<port> -RIPIP CONTrol = Listen
In this example, you must supply a port number for <port>.
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Table 3 Text Conventions (continued)

Convention

Description

Commands

The word “command” means you must enter the command
exactly as shown in text and press the Return or Enter key.
Example:

To remove the IP address, enter the following command:
SETDefault!0 -IP NETaddr = 0.0.0.0

Note: This guide always gives the full form of a command in
uppercase and lowercase letters. However, you can

abbreviate commands by entering only the uppercase letters
and the appropriate value. Commands are not case-sensitive.

Screen displays

This typeface represents information as it appears on the
screen.

The words “enter”
and “type”

When you see the word “enter” in this guide, you must type
something, and then press the Return or Enter key. Do not
press the Return or Enter key when an instruction simply says

“type.”

[Key] names

Key names appear in text in one of two ways:

« Referred to by their labels, such as “the Return key” or
““the Escape key”

« Written with brackets, such as [Return] or [Esc].

If you must press two or more keys simultaneously, the key
names are linked with a plus sign (+). Example:

Press [Ctrl]+[Alt]+[Del].

Menu commands
and buttons

Menu commands or button names appear in italics. Example:

From the Help menu, select Contents

Words in italicized
type

Italics emphasize a point or denote new terms at the place
where they are defined in the text. (continued)_

Words in bold-face
type

Bold text denotes key features.

Equipment
Conventions

In this guide the term *““Edge device” refers to any of the following:
SuperStack Il Switch 2700, 7200/7400 ATM/Ethernet Interface Card,
7600 Fast Ethernet Interface Card, Super Stack Il Switch
1000/3000,NetBuilder Il, CoreBuilder 4000,Super Stack Il Switch 2000,
CoreBuilder 2500/6000 and CoreBuilder 5000 Switch Module and the
term “ATM Switch” refers to the CoreBuilder 7000 ATM Switch.



12 ABOUT THIS GUIDE



Chapter 1
Chapter 2

Chapter 3

GETTING STARTED WITH THE
ATM AND VLAN MANAGER

ATM and VLAN Management Overview
Configuring and Launching the ATM and VLAN Manager

Using the ATM and VLAN Management Application
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ATM AND VLAN MANAGEMENT
OVERVIEW

This chapter introduces you to the ATM and VLAN Management
application. The following topics are discussed:

« Whatis ATM and VLAN Management?

»« ATM and VLAN Management Maps

»« ATM and VLAN Management Tools

»« ATM and VLAN Management Assistants

What is ATM and
VLAN
Management?

ATM and VLAN
Management
Components

The Transcend ATM and VLAN Management application is a network
management software product used for managing switched virtual
networks and ATM infrastructures. With this application, you can
configure, controll and monitor location-independent virtual workgroups
that are created using different technologies based on ATM, Ethernet,
Fast Ethernet and FDDI.

The ATM and VLAN Management application manages virtual LANs on all
3Coms ATM and non-ATM switches.You can create virtual LANs with
either ATM-based (LAN Emulation) or non ATM-based
(Encapsulation/Tagging) methods.

The ATM and VLAN Management application allows you to view and
manage the network at various layers of logical and physical layers.
Specialized interrelated components are used to manage each abstracted
layer. This application provides the network manager with a global view
of the status, configuration, performance, and utilization of the ATM
infrastructure, LAN Emulation services, and network virtual LANSs.

The ATM and VLAN Management application is composed of the
following product components:

Maps
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Supported platforms

ig

Functions of ATM and
VLAN Management

= Tools
= Assistants or Wizards

These components are network models that represent network
information, based on the physical and logical structure of the network.

The maps represent the network model and status information. Different
maps are available for the different logical and physical views.

The tools perform various network management tasks and functions.
The ATM and VLAN Management tools can be launched from the
application or from within a web browser tool (locally or from a remote
location). If you launch the tools from within a web browser, only the
tasks that do not require any additional configuration assistants can be
performed. VLAN moves are allowed from the web interface.

The Assistants or Wizards configure and perform specific actions on the
network devices in the management maps. ATM and VLAN Management
Assistants are launched from maps or tools.

The ATM and VLAN Management application runs on all platforms
supported by OpneView Windows (OVW), NetView, and SunNet
Manager.

You must upgrade Netscape to version 4.03 with JDK1.1 support.
Upgrading to Netscape version 4.03 is insufficient to run the web-based
ATM VLAN software. You must have the JDK 1.1 support for the software
to run properly.

You can dowload JDK software from the JAVA site currently at the
following address:

http://developer.netscape.com/software/index.html?co
ntent=jdk/download.html

The ATM and VLAN Management application is identical for all platform
environments. You can perform network management operations and
functions from any workstation.

The ATM and VLAN Management application provides the following
functions:
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« Automatic discovery of switched network topology (physical and
logical)

= Continuous state and status monitoring of relevant logical and
physical components with a scalable distributed polling engine.

« End-to-end ATM virtual circuit tracing and graphical display
=« Configuration of PVCs (Permanent Virtual Channels)

= Switch and link-level performance measurement with a network-wide
bandwidth monitoring and utilization monitoring tool

= Provides the network operator with distributed network management
and distributed viewing capabilities
Virtual LAN management capabilities include:

» Policy-based VLAN auto-configuration support

« Common user interface to manage VLANSs across all 3Com
VLAN-supported products

»« Management of ATM-based VLANs (LAN emulation) and
non-ATM-based VLANs (VLAN tagging, protocol-based)

»« Automatic discovery and logical segmentation of VLANs
» Color-coded, device-level mapping of physical infrastructure to VLANs

« VLAN moves with a simple drag-and-drop operation
Local Area Network Emualtion management capabilities include:
= Automatic discovery and display of the LANE service infrastructure

along with the ATM physical network structure

»« Mapping of LANE client-server relationships and association ofproxy
LAN Emulation Client (LEC) ports

» Virtual circuit tracing between LANE elements and mapping of
physical paths over the ATM infrastructure

« Graphic display of LEC and LES/BUS performance statistics
» LECS database synchronization management

= LANE service redundancy management and automatic failover
mechanism, isolation of LANE service faults and correlation of affected
devices and segments.
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ATM and VLAN
Management Maps

ATM Device Manager
Map

The ATM and VLAN Management application includes the following
maps:

ATM Device Manager map
ATM Network map

LAN Emulation map
Virtual LAN map

VLAN Policy map

Gigabit Network map

The ATM Device Manager map (see Figure 1-1), shows the physical
topology of the entire switched infrastructure in a single flat topology
map. The ATM Device Manager map provides the quickest access to all
ATM devices on the network. You also can select the devices graphic
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display to show the topology layout using the NMSetup tool. See
Figure 1-35 for a description on setting the devices map layout.

Figure 1-1 ATM Device Manager Map

You can display a device-oriented view including device front panels,
device statistics and device parameters using the ATM Device Manager
menus and submaps.
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Figure 1-2 shows an example of the graph and statistics of a CoreBuilder
device. For example, to access teh device statistics window, select the
device in the ATMVLAN Devices window and then from the ATMVLAN
menu select Graph Assistant.

4 P B0 |

Figure 1-2 ATM Switch Graph Assistant Window

Figure 1-3 shows the hierarchy in the Topology Browser. To access the
ATM Devices map, double click on the ATMVLAN Devices branch or select
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the branch and then select the Zoom icon. See page 1-27 for a
description of the Zoom icon.

Zoom icon Cross Reference icon Topology View
Component View

Figure 1-3 Access to the ATM Devices Map through the Topology Browser

To display the selected device in the Topology View, select the device in
the Component View and then select the Cross Reference icon.

ATM Network Map The ATM Network map (see Figure 1-4) allows you to perform
management tasks on different ATM devices,depending on their physical
connectivity. The ATM Network window displays a hierarchical switching
backbone of the network. Each icon represents a switching domain, such
as a central high-speed CoreBuilder ATM switch module that is connected
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to various ATM devices, such as a SuperStack Il switch 2700 and other
CoreBuilder modules. The lines connecting the ATM switching domains
indicate the P-NNI (Private Network to Network Interface) links between
them.

The ATM Network Map provides:

Displayof the connectivity between ATM switches (CoreBuilder 7000)
and ATM edge devices and end stations (SuperStack Il Switch
2700/1000/3000, CoreBuilder 2500, CoreBuilder 5000, NETBuilder,
ATM adapter)

Identification of port numbers on the links between switches

Statistics on traffic to and from different devices and through specific
device ports

Tracing and modification of virtual circuits between devices

Selection of ATM end points to perform ATM path tracing

Figure 1-4 ATM Network Map Main Display
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Figure 1-5 shows the ATM Switch map, which is an example of the
submap of the Network map.

Figure 1-5 ATM Switch Map
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Figure 1-6 shows the hierarchy in the Topology Browser from which you
can access the ATM Network map.

Figure 1-6 Access to the ATM Network Map through the Topology Browser

To display a selected switch in the Topology Browser, select a switch in the
Component View and then select the Cross Reference icon.

LAN Emulation Map The LAN Emulation map (see Figure 1-7), allows you to perform network
management tasks on the LAN Emulation clients and servers.

The LAN Emulation provides:



= ATM device display in the LAN emulation process
= Display of the LECS, LES,and LEC port connectivity
= Isolation of LEC, LES, and LECS faults

= Mapping of ELANs to VLAN ports display

=« Monitoring of LANE services performance

Figure 1-7 LAN Emulation Map Main Display

Figure 1-8 shows the Backbone and Services window which is an
example of a submap of the LAN Emulation window. This window
displays different emulated LANs, each with the LECs connected to the
central LES. The window also shows the active and or enabled LECSs.
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Figure 1-8 LAN Emulation Submap/Backbone and Services Window



Figure 1-9 displays the hierarchy in the Topology Tool from which you can
access the LAN Emulation Map.

R

Figure 1-9 Access to the LAN Emulation Map using the Topology Tool
Component View

To display a LAN Emulation component in the Topology View, highlight
the component in the Component View and then select the Cross
Reference icon.
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Virtual LANs Map

The Virtual LANs Map (see Figure 1-10), is used to manage the logical
connectivity of the end-user through the Virtual LANs. The Virtual LANs
maps provide views of the connectivity between Ethernet/ATM ports to
the different VLANSs. You use the Virtual LANs Map to manage ATM LAN
Emulation-based as well as legacy LAN encapsulated or tagged-based
VLANS.

The features of the Virtual LANs Map include:
= Re-configuration of VLANs

= Moving segments between VLANSs, using simple mouse actions
« Clarification of VLANSs to physical ports mapping

Figure 1-10 The Virtual LANs Map Main Display



Figure 1-11 shows the Ethernet segments that belong to a selected
VLAN.

Figure 1-11 The Virtual LANs Submap Displaying Ethernet Segments
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Figure 1-12 shows the hierarchy in the Topology Tool from which you can
access the Virtual LANs Map.
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Figure 1-12 Access to the Virtual LANs Map using the Topology Tool
Component View

To display components of the Virtual LANs map in the Topology View,
select the component in the Component View and then select the Cross
Reference icon.

ATM VLAN Policies The ATM VLAN Policies Map (see Figure 1-13), is used for automating the
Map event of the logical connectivity of end-users or segments through Virtual
LANSs, based on predefined policies. The maps displays the various



pre-defined policies that may be applied to network devices. The devices
that have policies applied are contained in the policy icon.

Note: The VLAN Policies may be used only with CoreBuilder 7000, Super
Stack Il Switch 1000/3000//2700 with ATM downlinks.

Figure 1-13 The ATMVLAN Policies Map
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Figure 1-14 shows the hierarchy in the Topology Tool from which you can
access the VLAN Policies Map.

e E =

2 '

Figure 1-14 Access to the ATMVLAN Policies Map using the Topology Tool

To display a component of the Policies Map in the Topology View, select
the component in the Component View and then select the Cross
Reference icon.

ATM and VLAN  The ATM and VLAN Gigabit Network Map shows the layer 2 topology of
Gigabit Network Map  Ethernet/Fast Eternity-based and in the future, Gigabit Ethernet-based



network backbones. The Gigabit Ethernet topology views can be used to
identify Virtual LAN trunks, downlink connections within the network.

Gigabithetaork

Figure 1-15 The ATM and VLAN Gigabit Network Map
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Figure 1-16 shows the hierarchy in the Topology Tool from which you can
access the ATM and VLAN Gigabit Network Map.

Figure 1-16 Access to the ATM and VLAN Gigabit Network Map using the
Topology Tool

To display a component of the Gigabit Ethernet Map in the Topology
View, select the component in the Component View and then select the
Cross Reference icon.

ATM and VLAN The ATM and VLAN Application Toolbar, see page 1-21, includes the
Management Tools Transcend Topology Browser. You access the Transcend Topology Borwser



The ATMVLAN
Toolbar

using the Topology icon. The Transcend Topology Browser can be used to
perform all the network management tasks that are performed using the
ATM and VLAN Management Maps and their assistants. The rest of the
application tools are used for displaying graphs and statistics and to
locate parameters and other information on your network.

The Topology, Locator, Bandwidth, Report, and Fast Setup tools are
accessible via a web browser. You can access the ATM and VLAN
Management Tools from any station with a web browser, independent of
the network management platform.

To access the ATM and VLAN management tools:
Open a web browser.
Enter the URL:

http://machine_ip_address/:7689/WebBase

The ATM and VLAN Manager Application Toolbar consists of the
following tools:
= Topology

=« Bandwidth
= Report

« Locator

» Users

« Profile

» Tasks

= Fast Setup

=  NMSetup

To invoke an option in the ATMVLAN Application Toolbar, click on one of
the icons.
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The ATMVLAN
Application Toolbar.

Icon Display

=

Topdogy
Eee——

Basdwidth

L@

|

il

.3

-
[

Hl i

Icon Name

Topology

Bandwidth

Report

Locator

Users

Profile

Tasks

FSetup

Description

Opens the Transcend Topology Browser.
The Topology Tool consists of the
Component View and Topology View. You
can perform most network management
tasks using this tool. See “Topology Tool”
on page 1-23.

Opens the NNIx Browser and NNIx
topology maps. Allows you to display and
view traffic patterns on the network. See
“Bandwidth Tool” on page 1-28.

Opens the NNIt Report Display with
information about the NNI traffic in tabular
format. See “Report Tool”” on page 1-29.

Opens the Locator Tool which is used to
search and locate the ATMVLAN databases.
See “Locator Tool”” on page 1-30.

Opens the Build UDB Tool that builds the
entire user’s database. See “Users Tool” on
page 1-31.

Opens the VN Pro Tool that lists an
inventory of devices and VLANs on the
network. See “Profile Tool” on page 1-33.

Opens the Spider Tool that displays the
current tasks on the network. See “Tasks
Tool” on page 1-36.

Opens the Fast Setup Wizard for the
CoreBuilder 7000. See “FSetup Tool” on
page 1-36.
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Icon Display Icon Name Description

Opens the NMS Fast Setup Wizard to setup
and configure the NMS platform. See

!| NMSetup “NMS Setup” on page 1-43.

Figure 1-17 The ATMVLAN Toolbar
55'1?4 | Topology Tool
Tesohay |

The Transcend Topology Browser, formerly called the Wizard Tool is
available as a part of the TEM 4.2.2 Unix release.

The Topology Tool (see Figure 1-18), is designed to manage Virtual LANs
and switched networks and can be used as a stand-alone (open
management platform independent) graphical network management
tool. The Topology Tool provides a consolidated interface for performing
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switched networks.
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Figure 1-18 The Transcend Topology Browser

In the absence of a management platform (such as HPOV etc.), this tool
can be used a the primary GUI for managing the switched network.

All management functions such as monitoring, configuration, statistics
gathering etc. can be performed using this interface.

The Transcend Topology Browser is comprised of two sections. The
section on the left is the Component View and the section on the right is
the Topology View.



The Topology View shows the layer 2 physical topology of large switched
infrastructures (networks with more than 500 Switches) in a single
hierarchy. For example, all the devices, such as ATM switches,
Fast-Ethernet Switches, and there corresponding edge devices, are
mapped.

The tree type Component View is hot linked to the Topology View and
allows for quick selection of infrastructure components that are
dynamically highlighted on the topology map. This feature allows you to
select an entry in the Component View, and view the highlighted
component in the Topology View using the Cross Reference icon.

For example, if you select a switch or an edge device from the ATMvLAN
Devices branch in the Component View, the selected switch is
highlighted in the Topology View. If you select a VLAN entry in the VLAN
branch, all the switches that belong to the VLAN are highlighted

The Component View has two windows for displaying the components.
The two windows allow for opening and viewing different branches at
the same time. For example, in the top window, a VLAN branch may be
opened displaying all the VLANSs. In the bottom window, a specific VLAN
branch may be selected, and the segments within the VLAN displayed.
When performing VLAN moves, segments may be selected from one
window (top or source), and the target VLAN may be selected from the
other window (bottom).

Traffic pattern overlays are planned for the future in the Component View
as the Topology View will be hot linked to the Bandwidth Tool.

The topology map includes the following icons:

= Zoom Out - This tool is used to magnify the topology map.
= Zoom In - This tool is used to reduce the topology map.

= Select Area - This tool is used to select an area of the topology map.
Use this tool by clicking on the icon and then defining an area (square)
on the topology map. The selected area is resized to fit the topology
map window. When used in conjunction with the Pan tool, you can
resize the selected area by resizing one of the rectangles handles using
MB1.

« Pan - The tool opens up a display window that allows you to pan the
entire network.
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= Refresh - This tool updates the network status.
The Topology Tool includes the following features:

= Rearrange - You can rearrange the components for display by
dragging them on the Component View to the desired location.

= Search - This feature allows you to enter an IP address and locate the
device on the Topology View.

« Highlight - The Component View, in conjunction with the Cross
Reference Tool highlights the component selected in the Topology
View.

= Identify - Use this feature to identify the device IP Address and its
name. You use the identify feature by clicking with the right mouse
button on the Topology View.

= Display Front Panel - The feature is the same as the Zoom Physical
feature in the ATM and VLAN Management application. You can
display device front panels by double clicking on the device in the
Topology View.

The Component View reflects the status of all the components that are
being actively polled by a distributed polling agent (medp). For customers
that do not want to use the platform maps, HPOV, Netview or SunNet
Manager, the Transcend Topology Browser may be used as the main
console.

For distributed viewing capability, the Topology Tool can be
accessed via a web browser.

You must upgrade Netscape to Version 4.03 with JDK1.1 support.
Upgrading to Netscape 4.03 is insufficient to run the web-based ATM
VLAN software. You must have the JDK 1.1 support for the software to
run properly.

The JDK software may be downloaded from the JAVA site currently at:

http://developer.netscape.com/software/index.html?content=jdk/downlo
ad.html
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Topology Tool
ATMVLAN Objects

rootear (G| ] | ]| ) ]| |12

Icon Display Icon Name Description
Zoom Zooms in on the selected branch. Performs
Q\ the same zoom action as when you select
an icon and then select ATMvLAN - >

Zoom Physical in the ATM and VLAN
management maps.

Configuration Opens up the Configuration window for
| |IT Assistant the selected branch. Performs the same
— action as when you select an icon and then

select ATMVLAN - > Configuration
Assistant in the ATM and VLAN
management maps.

Graph Opens up the Graph window for the
| . Assistant selected branch. Performs the same action
— as when you select an icon and then select

ATMVLAN -> Graph Assistant in the ATM
and VLAN management maps.

Reference LANScape Browser in the LANScape

] |] Cross Displays the component highlighted in the
topology map.

the selected branch. Performs the same
action as when you select an icon and then
select ATMVLAN - > Move in the ATM and
VLAN management maps.

I Move Opens up the Configuration window for

w4
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Icon Display Icon Name Description

M=l Path Assistant Opens up the Path window for the

I l:( | selected branches. Performs the same
_ action as when you select two icons and

then select ATMVLAN -> Path Assistant in
the ATM and VLAN management maps.

. Help Opens up the on-line Help files to help you
J |? use the ATM and VLAN Management

— application,

Bandwidth Tool

The Bandwidth icon opens the Network Node Interface Traffic Tool, NNIx,
(see Figure 1-19), and displays all the ATM switches and traffic patterns
on the NNI and UNI levels of switches. The NNIx Browser and Maps
provide a graphical display of the network link utilization. You can also
display the percentage of traffic on the network using the NNIx Maps.
The Bandwidth Tool is organized based on enhanced Interswitch Interim
Signalling Protocol (IISP) address hierarchy. This tool is used to log the
traffic information to a file, so that historical network-wide NNI link level
data can be gathered and displayed. The Bandwidth tool is also used to
graphically display errors on NNI links across the networks.

See Chapter 7 for a detailed description of the Bandwidth Tool.
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Figure 1-19 The Network Node Interface Traffic Tools

Report Tool

ﬁ The Report icon opens the Network Node Interface Tabular Tool, NNIt, see

#8851 | Figure 1-20, and is identical to the Bandwidth Tool, except that the
information is displayed in a report (tabular) format. The devices that are
linked are listed in a directional table, left to right or right to left. The
percentage of traffic and number of octets per second going through the
switches is also listed in the table.
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[EINNI Table

NHIT Monitor
Symbol: I ml
204, 140.204.140.172 0 0 155520000 32
0.0.0.0 0.0.0.0 0 0 0 0 0
0.0.0.0 0.0.0.0 0 0 0 0 0
0.0.0.0 0.0.0.0 0 0 0 0 0
0.0.0.0 0.0.0.0 0 0 0 0 0
0.0.0.0 0.0.0.0 0 0 0 0 0
0.0.0.0 0.0.0.0 0 0 0 0 0
0.0.0.0 0.0.0.0 0 0 0 0 0
0.0.0.0 0.0.0.0 0 0 0 0 0
0.0.0.0 0.0.0.0 0 0 0 0 0
0.0.0.0 0.0.0.0 0 0 0 0 0
0.0.0.0 0.0.0.0 0 0 0 0 0
Legend: hx 10% 20% 40% 100%

i

Figure 1-20 The Network Node Interface Tabular Tool

Locator Tool

The Locator Tool, (see Figure 1-21) functions as a search and modification

' tool to the ATM and VLAN application’s databases. These databases are

built using other tools. For example, the MAC VDB database is built using
the Build UDB Tool. The Manual Discovery database is built using the
Manual Discovery Setup. See “Configuring Manual Device Discovery” on
page 4-1. The VLAN Aliases and Colors database are built using the VLAN
Aliases and Colors Setup. See the description of setting VLAN aliases and
colors on page 4-20. The Locator searches these databases and allows
you to modify parameters within them.
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The Locator Tool uses a search string that is color-coded and displays all
other parameters for the selected string in the bottom portion of the
dialog box.
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Figure 1-21 The Locator Tool

Users Tool

The Users Tool opens the Build UDB tool, see Figure 1-22, is used to build
a parameter database for storing all the information related to MAC
addresses in the network. The Users Tool performs an inventory of the
existing network, automatically discovers the MAC addresses that exist
and their respective locations (device, port) and their current VLAN
mapping. The parameter database populated by the Build UDB tool may
be modified manually to change VLAN mapping. Use the Locator Tool to
edit the database. Devices that enforce the MAC based Automatic VLAN
configuration policy will query this database to resolve MAC address to
VLAN mapping.
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Since the Build UDB Tool requires lots of CPU as well as generates a lot of
SNMP traffic, we recommend that you use this tool during periods of low
network activity.

— :

Figure 1-22 The Build UDB Tool



Profile Tool
_| The Profile icon opens the VnPro Tool that lists all the network devices
and their associated VLANS. This tool provides a comprehensive inventory
of all the VLANSs in the network.

Figure 1-23 The VnPro Tool

The top section displays the VLAN Configuration. The devices, and the
associated port numbers and VLAN names are displayed.

To use the VnPro Tool:
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Highlight a line in the display.The bottom section displays the information
for the selected line. The bottom section of the VnPro Tool is used for
display purposes only.

The Options menu allows you to perform the following:

= Move

= Refresh
=« Save As
»  Quit

The Move option is not implemented in this release.

The Refresh option allows you to update the VLAN Configuration table
for the latest device and VLAN information.

The Save As option saves the VnPro information to file. The information
can be saved as text or to a file capable of being opened in Excel.

Enter path or folder name;

| tusriacons |

Filter Files

(4.0 echoudp .
loadATHN _Wlan

Folders e deonsole

- o oomsol e
nod fava N
ncd javaback
nidwish
[y o

Enter file namse:

|'-.'nPr\-:|.'tai.-ﬂ

0K | Update  Cancel |

Figure 1-24 VnPRo Save As dialog box



The Quit option exits the VnPro Tool.

A VLAN may be defined without ports when the VLAN is defined in the
edge device (Vbridge is allocated) however, the VLAN ports are not
associated with the VLAN at this point.
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Tasks Tool

The Tasks icon opens the Spider Tool (see Figure 1-25), that provides a
graphical display of the underlying distributed processes in the ATM and
VLAN Management application. This is only a graphical display tool used
to illustrate the underlying network-wide configuration
infrastructure/engines and their logical layout. This diagnostic tool
displays the active processes and the devices they are applied upon.

= Graph o

Figure 1-25 The Spider Tool

FSetup Tool

The Fast Setup Tool is a wizard that allows you to configure the
CoreBuilder 7000 through the ATM and VLAN Management application.
It is a step by step procedure that prompts you to enter the CB7000
parameters required for network management.

To use the Fast Setup Tool:

Click on the FSetup icon in the ATMVLAN Toolbar. The CoreBuilder 7000
first Fast Setup Wizard Panel is displayed. See Figure 1-26.
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Figure 1-26 Fast Setup Wizard Step 1
To select the CoreBuilder 7000

1 Enter the CoreBuilder 7000 IP Address or select an address from the drop
down menu.
2 SNMP Community String.

3 Click Next. Panel 2 is displayed.
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Figure 1-27 Fast Setup Wizard Step 2

1 Enter the Network prefix in the General Parameters wizard panel.
2 Click Next. Panel 3 is displayed.
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Figure 1-28 Fast Setup Wizard Step 3

1 Select whether you want the Resident LECS Service to be enabled on the
selected CoreBuilder. Toggling it on, immediately enables the LES Service.
The resident LECS Service does not need to be enabled for the LES Service
to be enabled.

2 Enter the User part of the Resident LECS.
3 Click Next. Panel 4 is displayed.
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Figure 1-29 Fast Setup Wizard Step 4

1 Enter the prefix and user-part addresses of the Active LECS table.
2 Click Next. Panel 5 is displayed.



Figure 1-30 Fast Setup Wizard Step 5

1 Enter the maximum number of NNI hops.

2 Select the port settings.
The port settings may be either UNI, NNI or GW.
Click Next. Panel 6 is displayed.
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Figure 1-31 Fast Setup Wizard Step 6

1 Enter the Switch IP address, subnet mask and default gateway.
2 Enter the NMS address.

Figure 1-32 Fast Setup Final panel



This panel is to review your settings. Use the scroll bar to view your
settings. Click Prev to change settings. Click Finish to apply the settings.

The ATMVLAN NMSetup Wizard allows you to setup the NMS by
following the instructions on the screen.

To use the NMSetup Tool:

Click on the NMSetup icon in the ATMVLAN Toolbar. The NMSetup
Wizard Panel is displayed. See Figure 1-33.
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Figure 1-33 NMS Setup Step 1

Define the pollers and the devices that each poller is responsible for in the
Delegation MedP panel. Click Next. Step 2 is displayed. See Figure 1-34.
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Figure 1-34 NMS Setup Step 2 Delegation PDP

Enter the Device Set and the Target Poller and click Next. Setup 3 is
displayed. See Figure 1-35
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Figure 1-35 NMS Setup Step 3 Platform options

This panel allows you to enable platform options. You can save the
graphic display of the OpenView Maps by toggling persistent on.

If Manual Device Discovery is not toggled on, the application will discover
from the platform database. When toggled on, the application will rely
on manual population of the device database.

Click Next. Step 4 is displayed as in Figure 1-36.
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Figure 1-36 NMS Setup Step 4 Advanced Options

Define the number of seconds that the application will wait for the
network to settle down before it start the LES failure verification process.
This number could be tuned down to about 120 seconds if there are no
redundant switch engines in the network. If there are redundant switch
engines, the default number should be used.

Enter the fields in the Advanced options panel and click next. Step 5 is
displayed. See Figure 1-37.



Figure 1-37 NMS Setup Step 5 Locator
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Toggle on the appropriate fields and click Next. The final panel is
displayed showing your final NMS Setup settings. See
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Figure 1-38 NMS Final Panel Review Settings

ATM and VLAN
Management
Assistants

Configuration
Assistants

ATM and VLAN Management Assistants are launched from the ATM
VLAN Maps and Tools. These assistants are used to perform various
functions such as configuration of services, statistics gathering,
troubleshooting and other network tasks.

The configuration assistants are used to configure the network elements
in the management maps. ATM and VLAN Management Assistants are
launched from maps or tools.

The Configuration Assistants include:

» LECS Redundancy

» LECS Database Configuration and Synchronization
» LES/BUS Redundancy Setup and Activation

= VLAN Aliases and Colors Setup

See Chapter 4 for a more detailed description of these assistants.



CONFIGURING AND LAUNCHING
THE ATM AND VLAN MANAGER

This chapter contains the following topics:

» Configuring SNMP SmartAgents on Devices

» Device Configuration for VLANs in ATM Networks

» Device Configuration for VLANS in Non-ATM Networks
» Starting Up the ATM and VLAN Manager

= Device Discovery

All 3Com devices including CoreBuilder 7000, SuperStack Il Switch 2700,
SuperStack Il Switch 1000/3000, SuperStack Il Desktop Switch,
CoreBuilder 7X00, NetBuilder Il, CoreBuilder 4000, SuperStack Il Switch
2000, CoreBuilder 2500 and CoreBuilder 5000 Fast/Switch Modules may
be managed through the ATM and VLAN Management tools. Please refer
to the specific device Setup Manual for device initialization and setup
instructions.

NMSetup

HMSetup

The NMSetup Tool located in the ATMVLAN Toolbar, opens the NMSetup
wizard that allows you to set all the NMS configuration parameters and
values in a step by step procedure.

NMSetup

To use the NMSetup Tool:
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Click on the NMSetup icon in the ATMVLAN Toolbar. The NMSetup
Wizard Panel is displayed. See Figure 2-1.
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Figure 2-1 NMSetup Step 1

For a detailed description of the NMSetup Tool see page 1-43.

Configuring SNMP
SmartAgents on
Devices

The NMS performs physical layer management using the SNMP. The NMS
polls agents for status, configuration and network traffic information.

The first step in initializing the network for management is to configure
the SNMP SmartAgents in the 3Com ATM and VLAN devices.

To configure the SNMP SmartAgents on Devices:
Determine the management IP subnet and IP addresses to be used for the

ATM devices and the Transcend ATM and VLAN Manager Station.

Configure the IP address and default gateway in each ATM switch unit.
See the device Installation and Setup Guide for the switches you are
using.

It is recommended that all the ATM and VLAN devices be configured as
members of the same subnet as the Network Management Station



Configuring SNMP
SmartAgents and
Parameters
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Configuring SNMP SmartAgents on Devices  2-3

(NMS). This allows the NMS to access these devices directly over the ATM
network instead of going across routers.

Configure the IP address, and default gateway of Bridge O in each of the
edge device units. See the device Installation and Setup Guide for the
devices you are using.

Community names set on the NMS must correspond with community
names set on the agent(s). Configure the SNMP generic parameters on
the ATM and VLAN Network Manager as follows:

Configure the default SNMP Community Setting on the Network
Management Platform according to Table 2-1. See the Network
Management Platform Administration Manual.

Table 2-1 Configuring SNMP Community Settings

SNMP Community
Device Setting

CoreBuilder 7000 Private
CoreBuilder 7X00
SuperStack Il Switch 2700

SuperStack Il Switch Security
1000/3000/Desktop Switch

SuperStack Il Switch 2000  Private

CoreBuilder 2500/6000 Public
CoreBuilder 5000 Switch

Module

SuperStack Il Switch 2000  Security
TR

NetBuilder I Public
CoreBuilder 4000 Public

If default SNMP Communities are changed in the devices, you must enter
the new communities as well.

Verify the IP/SNMP connectivity using the IP Map.

All devices in the management subnet should appear on the IP Map of
the management platform. The IP connectivity is verified by the
appearance of the IP address. The SNMP connectivity is verified by the
appearance of the device icon. The process of establishing connectivity
should take about 5 minutes.
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Setting Up for
Distributed Polling

CAUTION: Do not start the ATM and VLAN Network Manager until all
the ATM and VLAN devices have been discovered and appear in the IP
Map of the management platform.

Polling in SNMP management is the activity whereby the NMS
interrogates/polls individual nodes on the network for their current
status. It is one if the most important sources of network management
control for traffic on the network.

The ATM and VLAN Management application maintains the status and
state of all the logical and physical components of the network. You
cannot rely on the platform poller alone (such as HPOV SNMP Poller)
which only maintains the “ping” status of the network when using the
application. The ATM and VLAN Management application uses a
platform-independent poller called the Mediation Poller or Medp to
actively maintain the status of all the components it is monitoring.

Starting the Poller Locally

In small networks consisting of less than a 100 network devices (ATM and
Non-ATM switches), a single central poller is adequate for polling the
network and maintaining the state of the logical and physical network. In
these types of networks, the Mediation Poller can reside on the NMS. The
default configuration installs the mediation poller when the ATM and
VLAN Management application is installed. The poller is initialized and
activated along with other network management platform processes.

Starting the Poller on Multiple Distributed Machines

When using the application to manage a larger network, consisting of
many network devices, or when the network is managed over a wide
area, it is possible to distribute the polling.

Distributing polling onto more than one machine has several advantages.
The advantages are:

= Localizes polling in remote sites so as not to send polling traffic on
WAN links.

» Distributes the polling load onto several machines to get better polling
performance and SNMP traffic distribution.

« Frees up CPU resources on the central management station, thus
providing better console performance.
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The following steps must be followed when installing distributed pollers:

Install the Transcend ATM and VLAN Management application on the
central machine on top of an open management platform such a HPOV.
In a distributed polling environment, this machine is the Central Viewing
Station or Central Management Console

or

install the Transcend ATM and VLAN Management application as a
stand-alone application, on other Unix machines (Solaris, AIX or HPUX).
An open management platform is not required. In a distributed polling
environment these machines are referred to as polling stations or pollers.
These machines do not require an open management platform such as
HPOV installed on them.

On the polling station, start the polling process:
a Change Directory to /usr/NCDNMS/make/
b Execute the file “medp.”

It is advised to include these steps in the boot configuration of the polling
station so that they are executed automatically when the polling station is
booted up.

Configure the ATM and VLAN Management application on the central
management station to recognize the distributed pollers and delegate
polling responsibilities to each poller.

Before starting the application, edit the following file:
/usr/NCDNMS/runtime/cnf/mediationd.cnf

Each line in the /usr/ANCDNMS/runtime/cnf/mediationd.cnf consists of
three fields, each separated by a colon. The upper lines in the files take
priority over the lower lines.

This customization of this file can be performed using the NMS
Setup Wizard.

The first field is the range of the IP addresses that devices will be polled
from. The second field is the poller IP address. The third field represents
the socket port number communication port. The default number for the
socket portis 1161
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An Example of Distributed Polling.

100.200.100.170-180:100.200.100.78:1161
100.200.100.*:100.200.100.79:1161
100.*.*.*:100.200.100.77:1161
****127.0.0.1:1161

Figure 2-2 A Listing of Contents from the
C:\TranscendNT\ATMVLAN\runtime\cnfimediationd.cnf

Line one displays the range of IP addresses (IP address 100.200.100) with
their last address field, address ending in numbers between 170 through
180, polled to IP address 100.200.100.78, poller numberl.

A hyphen should be used to indicate a range.

Line two displays all other IP addresses in subnet 100.200.100.*, are
polled to IP address 100.200.100.79, poller number 2.

A * should be used to indicate a wildcard.

Line three displays that all other IP address in subnet,100.*.*.*, are polled
to IP address 100.200.100.77, poller number 3.

Line four displays that all other address in the network are polled to
127.0.0.1, poller number 4 which represents the poller located on the
local machine.

Be certain that the last entry in the mediationd.cnf file contains a global
subnet (*.*.*.*) in the first field to ensure that all nodes in the network
are assigned to a poller.
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Device
Configuration for
VLANSs in ATM
Networks

CoreBuilder 7000
ATM Switch
Configuration

A Virtual LAN is logical port group spanning a single device or multiple
devices on a network forming a single broadcast or flooding domain.
When LAN Emulation protocols are used to create broadcast domains
over ATM-based infrastructures, these broadcast domains are also
commonly known as Emulated LANs or ELANs. Each Emulated LAN is
serviced by a single LES (LAN Emulation Server) and single BUS (Broadcast
Unknown Server). Endstations or network devices that join a common
Emulated LAN are said to be in a single ELAN or VLAN. These endstations
communicate with the LAN Emulation Services (LES/BUS) via another LAN
Emulation entity called a LAN Emulation Client (LEC).

To build and manage ATM/LAN Emulation-based Virtual LANs, the LAN
Emulation Services and Clients must first be manually configured into
their respective default states via device consoles or a local management
interface. Only after they are configured, can you use the ATM and VLAN
Management application to manage and manipulate the environment.

The CoreBuilder 7000 ATM Switch supports the LAN Emulation Services
(LES/BUS/LECS). Depending on the number of Emulated LANs that need
to be created, LANE services must be enabled on one or more
CoreBuilder 7000 switches in the network. You can use the CB7000 Fast
Setup tool to configure the CB7000 through the ATMvLAN Toolbar. See
“The CB7000 Fast Setup Tool”” on page 2-8.

The following guidelines should be followed when enabling LAN
Emulation Services on the CoreBuilder 7000.

When there are multiple CoreBuilder 7000s, the LAN Emulation Services
must be distributed amongst all the core switches.

For example, if 10 Emulated LANS are required and the network is
comprised of 5 CoreBuilder 7000s in the core of the network, you should
distribute the LANE Services on all the core switches.

All LANE services should be enabled on all the core switches. Since each
CoreBuilder 7000 supports 16 LES/BUS pairs, some of these LES/BUS pairs
may be configured as primary LANE servers of an ELAN and the others as
backup LANE Servers for the primary LES/BUS pair. See Chapter 4.

When there are multiple CoreBuilder 7000s, the LAN Emulation
Configuration Server (LECS) may be enabled on multiple switches. Up to
5 LECSs may be configured as active LECSs in the network. You should
enable LECSs on some of the core switches in the network.
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ATM Edge Device
Configuration

3 The Network Management Station should be connected directly to the
switch running the primary LECS. This will ensure that the NMS always
has access to the LECS so that it can enable the backup LES when the
primary LES fails. See ““Description of LES/BUS Redundancy” on page
4-10.

The CB7000 Fast Setup Tool

This CB700 Fast Setup icon opens a wizard that allows to configure the
CoreBuilder 7000.

To use the Fast Setup Tool.

Click on the FSetup icon in the ATMVLAN Toolbar. Step by step
procedures are displayed that allow you to configure the CB7000.
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ATM edge devices such as Super Stack Il Switch 2700, CoreBuilder 7200,
Switch 1000, CoreBuilder 5000 Switch Modules etc., provide the legacy
LAN-to- ATM integration. Some of these edge devices need to be
pre-configured to enable the LAN Emulation Clients within them.
Typically, this involves configuring the local bridge groups within the
devices and their corresponding LECs. Please refer to the appropriate
device configuration manuals for information on VLAN/ELAN
configuration of these devices.
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Device
Configuration for
VLANS in Non-ATM
Networks

Virtual LANs in non-ATM (Fast Ethernet) environments are created by
using Layer 2 encapsulation or Tagging as a means to create broadcast or
flooding domains. Ports that are common to multiple Virtual LANs are
known as Virtual LAN Trunks (VLT). Switch 1000/3000s and CoreBuilder
5000 Fast Modules support this feature. VLTs must be configured on the
switches prior to using the ATM and VLAN application to manipulate the
VLT-based VLANS. Please refer to the Switch 1000/3000/CoreBuilder
5000 Fast Module configuration manuals for information on VLT-based
Virtual LANS.
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Starting Up the
ATM and VLAN
Manager

Setting Up and
Customizing the ATM
and VLAN
Management
Application

This section describes the start-up procedure for the ATM and VLAN
Management application for the HPOV/OVW platform:

Before you begin to use the ATM and VLAN Management application
there are several tasks that you should perform to setup and customize
the ATM and VLAN Management application. They are as follows:

Login to the UNIX workstation and start the OVW. See “Login to the
UNIX Workstation and Start the OVW” on page 2-10.

Discover devices via the OpenView IP Map. See ““Discover devices via the
HP OpenView IP Map” on page 2-10.

Verify that you network is up and running. See “Verify that your network
is up and running.” on page 2-11.

Customize the VLAN colors and aliases. See “Customize the VLAN colors
and aliases.”” on page 2-11.

Customize some of the other application configuration files using the
NMSetup Wizard. See “Customizing the Application Configuration Files
on page 2-12.

Restart the ATM and VLAN Management application.

Login to the UNIX Workstation and Start the OVW

From the HPOV Root Window select ATMvLAN and then select Load
Transcend ATMVLAN Maps.

After a few seconds, icons representing the six ATM and VLAN
Management maps appear in the Root window. The ATMVLAN Toolbar
and the Virtual LANs and LAN Emulation windows appear.

Discover devices via the HP OpenView IP Map

Ping devices if they don’t appear in the IP map. Start the ATM and VLAN
Management application only after all the devices are discovered by
HPOV and are displayed in the IP map.

If you encounter problems discovering devices from the HPOV platform
database, or if you want to setup the application to ignore the platform



discovery database, you can manually discover devices using the Manual
Device Discovery Assistant. See “Using the Manual Device Discovery
Assistant” on page 4-2.

Verify that your network is up and running.

As the application begins, it is modeling (understanding the logical and
physical structure) the ATMVLAN network. The length of this process
depends on the size of the network. For larger networks, it may take up
to 15 minutes for your maps to be activated.

To check that the network modeling process is complete open the LAN
Emulation Map and verify that all of the icon colors have changed from
blue to yellow, green or red.

Common Startup Problems

If the root icons don’t change color from blue, it may be because either
the MEDP or PDP tasks are not running.

There are two ways to check that the MEDP and PDP process are running
on OVW or NetView:

= Use the ovstatus command

= Uuse the ps command

The ps command is used for the SunNet Manager to check if the
processes are running.

Customize the VLAN colors and aliases.

Customizing the VLAN aliases and colors enables the ATMvLAN device
view windows to show what VLANS each port is assigned to. If you do
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Customizing the
Application
Configuration Files

not customize the colors and alias settings, device view VLAN moves can
not be applied.

Select the Virtual LANs icon and then select the Configuration Assistant
icon. This displays the Virtual LANs configuration window.

VirbualANs
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Figure 2-3 Virtual LANs Configuration Assistant

Create the VLAN alias and color mapping.
To select a VLAN aliases and associated names:

a Select the VLAN ID from the pop-up list.
b Type in the new VLAN Name.

Select the VLAN color from the pop-up list.
Click Add

Click Apply to save all the updated VLAN names and aliases. Close the
window by selecting File -> Close. The changes are applied only after
the ATMVLAN Management application is unloaded and re-loaded.

o o

There are several settings that can be customized by modifying the values
in files stored in the C:\usr\TranscendNT\ATMvLAN\runtime\cnf and
C:\usr\TranscendNT\ATMVLAN\runtime\dat directories. These settings
affect various features of the ATM and VLAN Management application
and can make your ATM network easier to manage. Once changed, the
application needs to be unloaded and reloaded for them to be applied.



These files and directories must be backed-up before installing/upgrading
to a newer release of the ATM and VLAN Management application.

The ATMVLAN NMSetup Wizard allows you to modify these configuration
files. This customization will take effect upon restarting the application
after the customization is performed using the customization Wizard.

Table 2-2 lists the names of the some files that you can customize using

the NMSetup Wizard.

Table 2-2 ATMVLAN Customization Files

Filename

Description

mediationd.cnf

noplatdis.cnf

127.0.0.1.ppp

numcpsrvs.cnf

protimeout.cnf

VnRgb.dat

This file has the information about all the distributed pollers
and the devices that each poller is responsible. The setup of
distributed pollers is explained in the See ““Setting Up for
Distributed Polling” on page 2-4.

This file is customized by the Setup Wizard.

If this file exists, the application will not discover from the
platform database. It will rely on manual population of the
device database
(C:\TranscendNT\ATMVLAN\runtime\sav\127.0.0.1.ppp)
using the Manual Discovery Tool. The default is to use
platform discovery and this file by default is
noplatdis.cnf.bak

This file is customized by the Setup Wizard

The number set in this file (1-16) determines the number of
LESs displayed in the maps. So if you are only using 2
LES/CoreBuilder, set the number to 2 and only the first 2
LESs of the CoreBuilder are shown in the maps.

This file is not customized by the Setup Wizard.

The number in this file determines the number of seconds
that the application will wait for the network to settle down
before it start the LES failure verification process. This
number could be tuned down to about 120 seconds if
there are not redundant switch engines in the network. See
Chapter 4 for a more detailed description. If there are
redundant switch engines, the default number should be
used.

This file is customized by the Setup Wizard.

Is the file where the VLAN aliases and color information is
saved after the aliases and colors are set. This file must be
saved when the application is upgraded to a newer release.

This files is customized by using the VLAN Aliases and
Colors setup assistant.
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Table 2-2 ATMVLAN Customization Files

Filename Description

Spider.cnf This file format is similar to the mediationd.cnf file. The
contents of the file define the location of the distributed
proxy smart Agents (pdp). It can either point to the local
host or a remote proxy agent. You can assign different
proxy agent to different IP address ranges. These proxy
smart agents are used for Policy based VLAN configuration,
data collection for NNIx tool, MAC address inventory etc.

#

# NCD JAVA Configuration File
#

# PDP List

# Devices: PDP ip: PDP port
***%127.0.0.1:6790

This file is not customized by the Setup Wizard.

Restart the ATM VLAN Application
Unload the ATMVLAN Maps and then reload them.

To unload, select all six ATMVLAN root icons. From the ATMVLAN menu
select Unload Transcend ATMVLAN Maps. This allows all the configuration
files, color, and alias changes to take affect. Be sure to unload the ATM
and VLAN application before you exit HPOV/OVW. Failure to do so will
prevent the application from loading successfully next time HPOV/OVW is
launched.



Device Discovery

Re-discovering
Devices

Devices are discovered only if they are up and respond to SNMP queries.
The devices must appear in the management platform's IP Map first.

You can update the application to include new ATM and VLAN devices
while the application is running. New devices are ones that have been
added after you have initialized the application.

To update and include the new devices:
Select ATMVLAN --> Load Transcend ATMVLAN Maps.

This procedure may be performed only at intervals of 15 minute or more.
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UsSING THE ATM AND VLAN
MANAGEMENT APPLICATION

This chapter describes how to use the ATM and VLAN management
application user interface.

The following topics are discussed:

« Navigating ATM and VLAN Maps

» Using the ATM and VLAN Tools

» Using the ATM and VLAN Assistants

Navigating ATM
and VLAN Maps

Figure 3-1 displays the Root Window of the ATM and VLAN Manager as it
is displayed after starting the application. Each icon opens into several
submaps, depending on your network structure, to display the physical
and logical components of the netwgrk.

il Eant

Figure 3-1 The ATM and VLAN Manager Root Window
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To navigate through a submap:

Click on an icon then select Zoom Physical from the ATMVLAN menu.

Table 3-1 Window Access From the Root Window

Window Name

Select

Action

Description

Root

ATMVLAN Devices

Virtual LANs

LAN Emulation
ATM Network
ATMVLAN Policies

Gigabit Network

Double click on the icon or select
ATMVLAN -> Zoom Physical.

Doubile click on the icon or select
ATMVLAN -> Zoom Physical.

Double click on the icon or select
ATMVLAN -> Zoom Physical.

Double click on the icon or select
ATMVLAN -> Zoom Physical.

Double click on the icon or select
ATMVLAN -> Zoom Physical.

Doubile click on the icon or select
ATMVLAN -> Zoom Physical.

Opens the ATM vLAN
Devices window. See
Figure 3-2.

Opens the Virtual LANs
window. See Figure 3-7.

Opens the LAN Emulation
window.

Opens the ATM Network
window.

Opens the ATMVLAN Policies
window

Opens the Gigabit Ethernet
window.

You can also navigate through submaps using the Topology Tool. Double
click on the Component View entry to see the sub-maps.
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ATMVLAN Devices The ATMVLAN Devices Map displays all the ATM and VLAN devices on the
Map network. Each device is represented by an icon. Each device is color
coded according to its current status in the network

| ATMYLA NI oS

Figure 3-2 The ATMVLAN Devices Window

For the SuperStack Il and CoreBuilder products to get true colors of the

b device front panel, click on the front panel. This updates the colors of the
front panel. This may temporarily change other colors on the screen To
return to the original colors, click on the front panel window.

Table 3-2 Window Access from the ATMVLAN Devices Map

Window Name  Select Action Description
ATMVLAN Devices SuperStack Il Switch Select the device and then from  Displays front panel view.
2700 the ATMVLAN menu select Zoom See Figure 3-3.
Physical.
CoreBuilder Module Double click or from the Displays front panel view.
Device Manager ATMVLAN menu select Zoom See Figure 3-4.

Physical.
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Table 3-2 Window Access from the ATMvVLAN Devices Map

Window Name  Select Action Description

CoreBuilder 2500/6000 Double click or from the Displays front panel view.

or LANplex 2016/5000 ATMVLAN menu select Zoom See Figure 3-5.

Module Device Physical.

Manager

CoreBuilder 5000 Double click or from the Displays front panel view

Module Device ATMVLAN menu select Zoom

Manager Physical.

Switch 1000/3000 Double click or from the Displays front panel view

Module Device ATMVLAN menu select Zoom

Manager Physical.

ATM SuperStack Il Double click or from the Displays stack front panel

Switch 2700 Array ATMVLAN menu select Zoom view. See Figure 3-6.
Physical.

To display a device front panel using the Transcend Topology Browser:

1 Select the device in the Component View portion of Topology Browser.
2 Select the Zoom icon in the Topology Browser toolbar.

or

Doubile click on the device in the Component View of the Topology
Browser.

Figure 3-3 SuperStack Il Switch 2700
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Figure 3-4 CoreBuilder Front Panel Display
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Figure 3-5 CoreBuilder 2500 Module Device Manager Front Panel Display
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Figure 3-6 ATM SuperStack Il Switch 2700 Array
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Virtual LANS Map  The Virtual LANs Map is used to display the VLANs and the associated
segments in the network.

Figure 3-7 The Virtual LANs Window

Table 3-3 Window Access from the Virtual LANs Map

Window Name  Select Action Description

Virtual LANs A Virtual LANs group Double click or from the Displays the segments
ATMVLAN menu select Zoom belonging to the selected
Physical. VLAN. See Figure 3-8.

To locate the Virtual LANs in the Topology Browser Topology View:

1 Select the Virtual LAN in the Component View.
2 Select the Cross Reference icon in the Topology Browser Toolbar.

The devices containing the selected VLAN(s) is highlighted in the
Topology View. See Figure 3-10.
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Figure 3-8 The VN-elan window

Table 3-4 Window Access from the Vn-elan Map

Window Name  Select Action Description
VN-elan One or more segments From the ATMvLAN menu select Moves the segments to a
and a VLAN in the the Move icon. different VLAN.

Virtual LANs window.
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Figure 3-9 Cross Referencing VLANSs in the Transcend Topology Browser



LAN Emulation Map

The LAN Emulation Map displays an overview of Emulated LANs. The
Backbone and Services in the center are connected to the peripheral,
non-backbone, ATM devices, which include edge devices or ATM
endstations participating in Emulated LANSs.

Figure 3-10 The LAN Emulation Window

Table 3-5 Window Access from the LAN Emulation Map

Window Name  Select Action Description
LAN Emulation Backbone and Services Double click, or from the Displays Backbone and
Icon ATMVLAN menu select Zoom Services window that shows
Physical. the LECSs, LESs and BUSes
LANE User Double click, or from the Displays LANE User window.
ATMVLAN menu select Zoom
Physical.
LECS icon Double click, or from the Displays front panel.

ATMVLAN menu select Zoom
Physical.
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Table 3-5 Window Access from the LAN Emulation Map

Window Name  Select Action Description
LES Double click, or from the Displays LECs map showing
ATMVLAN menu select Zoom all LECs connected to the
Physical. LES.

ATM Network Map

To display the LAN Emulation components in the Topology Browser:

1 Select the component in the Topology Browser Component View.

Select the Cross Reference Tool.

You can examine the overall structure of the ATM Network and the
connectivity of edge devices. In particular, you can examine the following
items:

= ATM Switch topology at Network-to-Network Interface (NNI) level

= Connectivity Between ATM Switch Domains at NNI level

« Edge Device connectivity at User-Network Interface (UNI) level

« Virtual Channels across NNI and UNI Interfaces.

= List the ATM address space of the Network

The ATM Network Map displays the most up to date physical connectivity
of the network. If a link between two switches fails, the map deletes the

link from the ATM Network Map instead of displaying the link in the
critical (red) state.

To detect unexpected changes in the network configuration, you can
maintain snapshots of windows of interest. These snapshots may be used
as a baseline for comparison, for example, of detecting a link fault. Link
faults can cause a link icon to disappear from a window.

The snapshot facility is located in the Map menu of HPOV.
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Figure 3-11 The ATM Network Map

Table 3-6 Window Access from the ATM Network Map

Window Name  Select Action Description

ATM Network ATM Switch Double click, or from the Displays ATM Switch window
ATMVLAN menu select Zoom
Physical.

ATM Switch A device Double click, or from the Displays the front Panel
ATMVLAN menu select Zoom Device View
Physical.

To display the ATM Network components in the Topology View:

1 Select the component in the Topology Browser Component View.
2 Select the Cross Reference Tool.
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ATM and VLAN The ATM and VLAN Policies Map shows the different automatic VLAN
Policies Map  configuration policies you can use to assign to the VLAN devices.

Figure 3-12 The ATM and VLAN Policies Map

Table 3-7 Window Access from the ATM and VLAN Policies Map

Window Name  Select Action Description
ATMVLAN Policies A policy Double click, or from the Opens the Policy-based
ATMVLAN menu select Zoom window.
Physical.
Policy-based One or more segments and  Double click, or from the Moves the segments to the
window. a policy icon (to remove a ATMVLAN menu select the Move newly assigned policy.
segment from any policy, icon.

move it to the Null Policy.

To display the ATMVLAN policies components in the Topology Browser
Topology View:

1 Select the component in the Topology Browser Component View.
2 Select the Cross Reference Tool



Using the ATM and
VLAN Tools

The ATMVLAN
Toolbar

The ATM and VLAN Toolbar automatically appears when you start up the
ATM and VLAN Management application. The tools may be used to
perform various network tasks and also provide you with an assortment
of status displays.

The ATMVLAN Toolbar, see Figure 3-13, is displayed when you startup the
ATM and VLAN Management application.For a description of the
ATMVLAN Toolbar see page 1-21.

Figure 3-13 The ATMVLAN Toolbar
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You can perform all the ATM and VLAN Management applications tasks
using the Transcend Topology Browser. The other ATM and VLAN tools
are used for display purposes and database modifications. You can also
view the status of traffic and other network parameters using some of
the tools.

To invoke one of the tools, double click on the icon. See Section 2 for a
description on how to use these tools to perform network management
tasks.

Using the ATM and
VLAN Assistants

Configuration
Assistants

There are four types of assistants: configuration, graph, path and
performance. You can use these assistants to setup parameters trace
paths, and see the performance of your devices on the network.

The following section describes the ATM and VLAN configuration
assistants.

Backbone and Services Configuration Assistant

To launch the Backbone and Services Configuration Assistant:

1 Select the Backbone and Services icon from the LAN Emulation Map

Select Configuration Assistant from the ATMVLAN menu.
To set up the LECS database:

Synchronize the LECS databases. See “LECS Database Creation and
Synchronization” on page 4-8.

Setup the LES/BUS redundancy and activate it. See ““Description of
LES/BUS Redundancy’ on page 4-10.

Manual Device Discovery Configuration Assistant

The Manual Device Discovery Configuration Assistant is used to manually
enter devices into the managed devices list.

To launch the Manual Discovery Assistant:

1 From the Root window select the “ATMVLAN Devices™ icon.
2 Select Configuration Assistant from the ATMVLAN menu. See “Using the

Manual Device Discovery Assistant” on page 4-2.



Graph Assistants

Path Assistants

LE Path Assistant

VLAN Aliases and Colors Configuration Assistant

The VLAN Aliases and Colors Assistant is used to setup the VLAN aliases
and colors.

To launch the VLAN Aliases and Colors Assistant:

1 From the Root window, select the Virtual LAN icon.

Select Configuration Assistant from the ATMVLAN menu. See
“Configuring VLAN Aliases and Colors™ on page 4-21 for a more detailed
description.

To use the graph assistants you select the network component and then
select ATMVLAN -> Graph Assistant.Graph assistants display the statistics
of the selected component.

If you want to see the path between two devices or between network
components, select the devices and then select the Path icon.

The LE Path Assistant allows you to select any two LE Clients or two
Ethernet segments to obtain the following information:

= Address resolution through the LE Server

» Control distributed path (direct)

= Multicast forward addressing through the BUS
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Figure 3-15 This Window Displays the VC Path Between Two Ethernet
Segments.

The Path Assistant see Figure 3-15,displays the corresponding segment,
its proxy client and its LE services ATM address and assists in verifying that
the connections are viable.
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Chapter 4
Chapter 5
Chapter 6

Chapter 7

OPERATING THE ATM AND
VLAN MANAGER

This section provides step-by-step instructions for performing network
management tasks using the ATM and VLAN Management application.

Network Configuration Tasks
Network Modification Tasks
Network Troubleshooting Tasks

Network Performance Measurement Tasks
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NETWORK CONFIGURATION TASKS

This chapter describes how to perform the following ATM and VLAN
Management network configuration tasks using various configuration
assistants.

The following topics are described:

»« Configuring Manual Device Discovery

»« Configuring LAN Emulation Services

» LANE Redundancy Planning and Setup Guidelines

»« Configuring VLAN Aliases and Colors

» Configuring Policy-based VLAN Auto-configuration

» Configuring and Using the MACvDB

=« Configuring IP Subnet-based VLAN Auto-configuration

=« Configuring or Viewing Administrative Status of ATM and VLAN
Components

= Configuring PVCs

Configuring When running the ATM and VLAN Manager, devices are discovered
Manual Device automatically from the platform database. The application can also be
Discovery configured to manually discover devices if you encounter difficulties with

automatic device discovery from the platform database or if you want to
work in the stand-alone mode. The application can either run in the
manual discovery mode or automatic discovery mode. In the manual
discovery mode, the application will read a static device file that is
manually created using the manual discovery configuration screen.

The Manual Discovery Setup allows you to do the following:
« add devices from the database

=« delete devices from the database
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Using the Manual
Device Discovery
Assistant

ig
ig

= clear the entire database

You can sort all the device types according to all the fields contained in
the ATM and VLAN Devices database.

After you modify, change, add or delete devices from the ATM and VLAN
database you must restart the application for the modifications to take
effect.

To discover devices manually, you need to set the discovery mode to
Manual Discovery mode. Select the Manual Discovery toggle in the
Manual Discovery Setup window. See Figure 4-1. You must also enable
Manual Discovery mode either through a customization file or the
NMSetup Wizard. See Chapter 1, Figure 1-35.

After the mode is set, the device database must be manually populated
using the manual discovery database configuration assistant.

Once the database is populated, the ATM and VLAN application must be
restarted to recognize the newly entered devices.

If you select automatic (platform) discovery from the Manual Discovery
window, changes entered manually are overwritten by the platform
discovery.

To use the Manual Device Discovery Tool:

From the Root window, select the ATM Devices icon and then select the
Configuration Assistant from the ATMvVLAN menu, or in the Topology
Browser, select an ATMVLAN Device branch and then select the
Configuration icon.



Figure 4-1 Manual Discovery Setup Window

All devices appear initially with the default Community Name and Polling
Interval settings. These entries may be modified by changing the
Community Name in the appropriate field or using the Polling Interval
cascade to select a new value.

The window is divided into three sub-windows. The first section displays
all parameters pertaining to the selected device type. The initial values
that are displayed in section 1 pertain to the device at the top of the
selection list in section two. The second section displays all the ATM and
VLAN devices that are in the database.

Section 3 contains radio buttons of all the fields in the database. You can
sort all the devices according to the field selected by clicking on the
appropriate radio button.
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Viewing the Manual
Device Discovery
Database

Adding Devices

1 Enter the device’s parameters in the display fields of section 1

Click Add.

Modifying Devices

Double click on a row In the scrolling region. The device and its
parameters appear in the display fields of section 1

or

select a Device Type from the cascade in section 1 and enter its
parameters.

Click Add.

The System verifies that the IP address is unique before adding a device to
the database.

Repeat for adding multiple devices.
Click Apply and restart the ATMVLAN Manager for modifications to take
effect.

Deleting Devices
You can delete one or more devices at once from the ATMvLAN database.

1 Highlight one or more rows in the scrolling region.
2 Click Delete.
3 Click Apply and restart the ATM and VLAN Manager for modifications to

take effect.

Clearing the Entire Database
To delete all of the devices from the database at once.

1 Click Clear.
2 Click Apply and restart the ATM and VLAN Manager for modifications to

take effect.

You can also view and search all the parameters in the manual discovery
database using the Locator Tool.

Do not use the Locator Tool to modify the Device Database.
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To use the Locator Tool to view the Manual Discovery database:

1 Select the Locator Tool.
2 Select the Device Database tab. See Figure 4-2.
3 Select Search to display all the parameters in the database.
The parameters are displayed.
To conduct a search based on a specified parameter.
1 Select the parameter from the Search Field.
2 Enter the search string (may be a partial value) in the Value field.
3 Select Search.
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Figure 4-2 Locator Tool Manual Discovery Database
Configuring LAN The Backbone and Services Configuration Assistant allows you to perform

Emulation Services the following functions all in the same window:

= Set the priority order and activate the LECSs in a multiple redundant
LECS network.
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= Set up the LECS database (Set the primary LES and set the backup LES
of each ELAN)

= Activate the Automatic LANE Redundancy Monitor

= Setup for Quick LANE Redundancy

Figure 4-3 The Backbone and Services Configuration Window



LECS Priority List
Setup
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To access the Backbone and Services Configuration Assistant:

From the LAN Emulation map or Topology Browser LAN Emulation
component, select the Backbone and Services icon or branch.

Select the Configuration icon from the Topology Browser or from the
ATMVLAN menu.

The Backbone and Services Configuration Assistant window is displayed
as shown in Figure 4-3.

The top sub-window within this setup screen allows for the setup of the
LECSs in the network. The application automatically discovers all the
LECSs in the network that are enabled or active and displays them. The
redundancy order can be changed/set according to the LECS priority.
When the redundancy order is changed, the change sets the priority
order and applies the order to all the CoreBuilder 7000s in the network.

A LECS may be in one of three states:

Enabled - The LECS can be configured but is unrecognized by all the
CoreBuilder 7000s in the network. The icon is colored yellow in the maps
or Topology Browser Component View.

Active - Each CoreBuilder 7000 in the network recognizes the LECS in
operation. You may have up to 5 LECSs in the Active state. The icon is
colored green

Disabled - The LECS cannot be recognized, enabled or activated by
network management. Icon is blue.

To change the priority order:
Use the middle mouse button and drag and drop the LECS to the desired
position.

For a two-button mouse, press both buttons simultaneously to drag and
drop.

Click Apply.

The LECS priority list is applied to all the CoreBuilders in the network.
Performing this step converts all the LECSs to the active state. When a
LECS is shown as active, it means that every CoreBuilder 7000 in the
network is aware of this LECS.
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LECS Database
Creation and
Synchronization

Enabling Automatic
LANE Redundancy

Quick LANE
Redundancy Mode

The second section is used to build the LECS database. This section allows
you to enter LAN Emulation Servers (LES) and their corresponding backup
LAN Emulation Servers into the LECS database. Initially, the LECS
database window shows the default LECS database displaying only a
subset of the LAN Emulation Servers that exist in the network.

The default LECS database (the subset) is taken from one of the LECS that
was discovered and shown in the first part of the form.

To build/modify the LECS database:

Select the admin and default elan ID from the toggle buttons on the side
of each entry.

Populate the database with all the ELAN IDs (LESs) and their
corresponding backup LESs using the selection buttons.

In order not to setup a backup for a LES, select the backup LES address to
be the same as the primary LES address.

Click Add to add the entry to the database or click Delete to delete
unwanted entries from the LECS database.

Click Apply

The LECS database shown in the window is applied to all the active and
enabled LECSs in the network. After this step LECSs are all said to be
synchronized.

The third section allows you to set up the Automatic LANE redundancy
procedure. There are three possibilities for Automatic LANE redundancy.

« Disabled - instructs the NMS not to automatically activate the backup
LES and a failure report is not issued.

= Report Only - The NMS issues a failure report but does not
automatically activate the backup LES.

= Report and Activate - The NMS issues a failure report and
automatically activates the backup LES.

The Quick LANE Redundancy mode button (which is selected by default),
allows for a quick LES/BUS failover to backup the LES/BUS, when the
primary LES/BUS fails. When this button is selected, the LANE redundancy
monitoring software performs some vital checks to determine if the



LANE Redundancy
Planning and Setup
Guidelines

Configuring LAN Emulation Services  4-9

primary LES is actually down and activate the backup LES upon
completion of the vital checks. These vital checks only take a few seconds
(10-15 seconds) to complete.

Quick LANE redundancy mode is recommended for most networks.

When the Quick LANE redundancy mode is not selected, the LANE
redundancy monitoring software will perform a more comprehensive
evaluation of the failed ELAN by checking the status of every LAN
Emulation Client (LEC) within the failed ELAN, status of the switch where
the primary LES resides before the LANE redundancy monitor activates
the backup LES. This is recommended only you want every aspect of the
ELAN to be checked before a backup LES/BUS is activated. Under working
in this mode, depending on the size of the network, the LES/BUS
redundancy could take 3-5 minutes to complete.

In addition to all the parameters configured from this window, an
additional timeout parameter must be configured in a file called
“protimeout.cnf” located in the /usr/ATMVLAN/runtime/cnf directory.
This timeout parameter determines the amount of time the LANE
redundancy monitoring software should wait before performing any
LANE service checks upon failure of a LES/BUS. This timeout allows for
the VCCs to ageout and the network to return to study state.

In the Quick LANE redundancy mode, this timeout parameter in this file
should be set to ““5”” seconds. When the quick LANE redundancy mode is
not selected, this parameter should be set to 120 seconds if there are no
redundant Switch Engines in the network and 333 seconds (default), if
there are redundant Switch Engines in the network.

Transcend Management Software supports the configuration/setup and
activation of the LANE Service (LES/BUS and LECS) redundancy feature.

The following lists guidelines to help you set up the LANE Redundancy
mechanism:

ATM address structure and physical network connectivity should allow for
ATM route recovery for cases of switch or link failure.

The primary and backup LES for an ELAN should not be on the same
switch.

The primary LECS should not be configured on a switch with primary
LESs.
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Description of
LES/BUS Redundancy

4 The Network Management Station should have direct access to at least

one LECS in the network, when an ELAN fails.

Do not use too many primary LESs on a single switch. Distribute the LESs
across the backbone.

Sixteen is the default number of active LANE Servers (LES) per
CoreBuilder7000 that can be viewed in LAN Emulation maps. You can
change the number of managed LANE servers for all CoreBuilders in the
network by editing the following file:

\TranscendNT\ATMvLAN\runtime\cnfinumcpsrvs.cnf

Change the number in the file to the number of LANE servers used. The
number should be less than or equal to the number of servers in the
CoreBuilder 7000.

If you manually change the LECS database on a CoreBuilder 7000 using
the console terminal interface, the Backbone and Services Configuration
tool may have problems reading the database in the CoreBuilder. If an
error message appears, manually reset the LECS database to the factory
default.

Workaround At the terminal prompt select 1, 2 and 7.
(1) SYS:Platform config
(2) RES:Reset config to factory default
(7) RBO:Reboot

LAN Emulation Services (LES/BUS/LECS) may be activated on each
CoreBuilder 7000 switch in the network. LAN Emulation Services allow
you to create Emulated LANs (ELANSs) on the ATM/Ethernet based
infrastructure. Given that each Emulated LAN is serviced by only one
LES/BUS pair, this could potentially become a point of failure. The LES/BUS
redundancy feature allows you to configure an additional LES/BUS pair
(running elsewhere in the network, on a different CoreBuilder 7000) as a
dynamic/hot backup for the primary LES/BUS pair servicing a particular
ELAN.

The ATM and VLAN Management software also works with non-3Com
device LECs when connected to a 3Com LECS. The LAN Emulation
Configuration Server (LECS) database may be configured with a primary
and backup LAN Emulation Server (LES) for each ELAN. Under normal
circumstances, the LECS serves (returns) the primary LES address when a
LAN Emulation Client (LEC) requests the LES address for an ELAN.



When LAN Emulation redundancy is activated on the NMS, see Activating
LANE Redundancy, and when a switch running the primary LES fails, the
NMS detects the failure. For the description of failure resolution, see ““LES
Failure Resolution” on page 4-11. The backup LES in the LECS database is
then activated.

It is critical that the NMS be connected directly to the switch running the
LECS or have direct access to this switch.

The LANE clients that go back to the Initial State (As per the LANE 1.0
Specification, the LECs have to go back to the Initial state when the
connection to the LES fails.) then re-establish connection with the LECS
(LECS Connect Phase and Configuration Phase) to get the LES address.
After the LANE Monitor on the NMS triggers the activation of the backup
LES in the LECS database, the LECS serves the backup LES address for the
requested ELAN. This enables all the LANE clients (LECs) to rejoin the
ELAN. The ELAN is thus served by the backup LES/BUS pair).

LES Failure Resolution

To prevent the activation of the backup LES/BUS when the primary LES is
actually active, the LANE Monitor software performs the following checks
to verify the failure.

Verifies that if any one LEC is in the operational state, the backup LES is
not activated. The primary LES is assumed to be active one.

Verifies that the switch running the primary LES is up and active. If this is
not verifiable via direct SNMP contact, you can verify whether the switch
is OK via the neighboring switches address tables.

If either check indicates a LES failure, the backup LES is activated. The LES
failure resolution is reported as inconclusive. You can manually active the
redundant LES.

These important steps ensure the integrity of LANE services and provide a
robust and reliable recovery mechanism.

Pre-conditions for LANE Redundancy to Take Effect

Some LECs cannot bind to the backup LES even when they get the
correct information about the backup LES from the LECS. This may occur
because of problems related to route redundancy. It is important to
ensure that ATM re-routing operates even when some links or a switch is
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down. If a LEC cannot bind to the backup LES, it is necessary to check if
the LEC can connect to the LES and the LES can in turn, connect back to
the LEC. Correct E-IISP planning for route failover/redundancy is required
for LANE redundancy to work.

How Does The Primary LES Regain Control of the ELAN?

The primary LES will not automatically start serving the ELAN when it
becomes active again, if the backup LES is activated. Since doing so will
result in both LESs being active at the same time and also may possible
cause a VLAN split.

The LECS continues to serve/return the backup LES address (even when
the primary LES is active again) until the LECS is manually reset to start
serving the primary LES address for ELAN configuration requests.

Restoring LANE Clients To Use The Primary LES

Restoring the LANE clients to use the primary LES may be done in one of
the following ways:

1 Automatic recovery to the to primary LES when the backup LES fails
2 Manually returning the Clients (LECs) back to the primary LES.

Automatic Recovery to the Primary LES when the Backup LES Fails

The primary LES and its backup LES can be configured in the LECS
database to back each other up. Under such configuration, the network
will automatically revert to the primary LES when the backup LES fails.

For example, if LES A is the primary LES and LES B is its backup, the LECS
database will contain an additional entry after the first entry with LES B as
the primary LES and LES A as its backup.

Using this setup, when the primary LES fails, the LECs connect to the
backup LES and remain there even though the primary LES becomes
active again. When the backup LES fails, the LECs connect back to the
primary LES.

When the switch is becomes operative, if a new LEC wants to join the
LES, it joins the primary LES of the ELAN that is currently being served by
the backup LES. This would result in a split ELAN. This condition must be
carefully monitored and fixed manually by first fixing the LECS database
Redundancy Assistant) and then resetting the new LECs.



Since an LECS may be located on the same switch as the primary LES, if
the primary LECS (primary LECS is the one on the top of the priority list)
fails along with the primary LES, its database cannot be altered by the
“LANE Monitor” to point to the backup LES when the LES failure
condition happens. This LECS’s database still points to the primary LES
while all the other LECSs point to the backup LES. Under these conditions
if new LECs (LANE Client) become active, they could join the primary LES
of the ELAN that is currently being served by the backup LES. This would
result in a split ELAN. This condition must be carefully monitored and
fixed manually by first fixing the LECS database (using the Manual LANE
redundancy Assistant) and then resetting the new LECs.

Manually Modifying LANE Redundancy

You can modify the database of an LECS that was not automatically
changed by the LANE monitor using the Manual LANE redundancy
Configuration Assistant.

To modify the database:

1 From the LAN Emulation window or Topology Browser select the
Backbone and Services icon or branch.

2 Select the Zoom icon or Zoom Physical from the ATMvLAN menu.
3 Select the LECS which contains the database you want to modify.

4 Select the Configure icon. The Manual LANE Redundancy window is
displayed. See Figure 4-4.
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Figure 4-4 The Backbone and Services Configuration Assistant/Manual LANE
Redundancy
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Each ELAN contains two entries of LES addresses.

5 For each ELAN, select the LES that was not automatically changed.
6 Click Apply to update the database.

Manual LANE Redundancy operates on only one LECS at a time. You can
select the LECS in the Topology Browser or in the Backbone and Services
map.

The Automatic LANE redundancy monitor, see the description on
page 4-8, must be disabled and then restarted after manually fixing the
LECS database.

The LANE clients that are split and located on the primary LES may be
moved to the backup LES using either one of the following methods:
Use the VLAN Move operation.

a Select the ports in the primary ELAN in the VLAN map.

b Move the ports to a temporary ELAN. (This temporary ELAN ID must
be in the LECS database)

¢ Move the ports to the backup ELAN.
Software reset the backup LES/BUS after modifying the database.

The software reset of the LES/BUS must be done via the Command Line
Interface of the CB7000. The software reset feature is only supported in
the CB7000 3.5 or later version.

Manually Returning the Clients (LECs) Back to the Primary LES

Returning the clients back to the primary LES should be done during a
scheduled network down time.

To manually force the LECs back to the primary LES you must first
perform the following:

Reset all the LECS databases using the Manual LANE Redundancy
Configuration Assistant.
Disable the “Automatic LANE Redundancy Monitor”.

After the above settings are adjusted you can return the clients back to
the primary LES by performing the either one of following tasks:



LECS Redundancy

a Move the ports in the backup ELAN to a temporary ELAN using the
VLAN move option. Then move the ports from the temporary ELAN to
the primary ELAN. It is important to first move to temporary ELAN first
and this temporary ELANID must be in the LECS database.

b Software reset the backup LES/BUS after modifying the database.

The software reset of the LES/BUS must be done via the Command Line
Interface of the CB7000. The software reset feature is only supported in
the CB7000 3.5 or later version.

Enable the Automatic LANE Redundancy.

The CoreBuilder 7000 switch supports LAN Emulation Configuration
Service. The LECS may be activated on more than one switch in the
network (up to 5).

Each CoreBuilder 7000 in the network is configured with the address of
the active LECS. The configuration of multiple active LECS addresses (up
to 5) is only possible using the LECS Select dialog box, upper part of the
Backbone and Services window.

One active LECS address can be entered via the command line interface
(LMA) and the remaining have to be set via the NMS. This limitation will
be eliminated in a future release of the CoreBuilder 7000 software.

How Do Lane Clients Take Advantage of Multiple LECSs?

If a LAN Emulation Client (LEC) uses the Well Known LECS Address (WKA)
to configure a direct connection to the LECS, the first CoreBuilder 7000 in
to which connection is established converts the WKA to the first active
LECS address (first among up to 5 LECS addresses programmed into the
CoreBuilder 7000 via the LMA and NMS). The CoreBuilder 7000 then
forwards this connection request to the active LECS. If the connection
setup fails, the CoreBuilder 7000 changes the WKA to the next active
LECS address and then tries to connect again. This process is continued
until an active LECS is reached. If none of the LECSs are reachable, then
the direct configuration setup request is rejected.

If a LAN Emulation client does not support the use of WKA, it may also
request the LECS addresses from the CoreBuilder 7000 via the ILMI and
try to reach the LECSs directly.
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An Example of Setting Up and Activating LANE Redundancy

The following is an example of a simple 2 CoreBuilder 7000 setup
demonstrating the LES/BUS and LECS redundancy.

Equipment (Hardware)
[CoreBuilder 7000 B]-----[CoreBuilder 7000 A]------ [7200/2700 A]
|

|
[2700/7200 B]--------- [NMS]

Software
3.1 or later version running on CoreBuilder 7000 and LS2700/7200
Hardware configuration: CoreBuilder 7000 A:

= ATM address A*

« |IP addr/Gateway/Mask

= LECS active

= LES/BUS active

= Active LECS address: Use Default (pointing to a*)

Hardware configuration: CoreBuilder 7000 B:

= ATM address B*

« |P addr/Gateway/Mask

» LECS active

» LES/BUS active

= Active LECS address: Use Default (pointing to A*)
LS2700/7200 (A and B)

Bridge 0: Ports 1-6, ELAN name: admin, IP address/Gateway/Mask.

Bridge 1, ports 7-12, ELAN name: use ELAN ID elanxxx_0 from switch
B (NOTE: the LES/BUS for bridge 1 must be on switch B)



To configure the NMS:

1 Connect the NMS to port 1 on one of the 2700s.
2 Ping all the devices. Be certain that both the CoreBuilder 7000

management ports are connected to the bridge 0 ports on the 2700s.
Make sure they appear in the HPOV IP map.

Run the ATMVLAN application.

Make sure all that all the devices appear in the ATM Devices Map and
that the LES/BUSs from both the CoreBuilders appear in the LAN
Emulation Backbone and Services map.

Be certain that there are segments in the admin VLAN, they will appear as
VN-ELANxxx_0, and in the 2nd VLAN (bridge 1 VLAN) in the VLAN Map.
Only two VLAN icons appear green, the rest appear brown indicating that
they are empty.
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To setup LANE Redundancy (LES/BUS/LECS):

1 From the LANE Emulation map or Topology Browser, select the Backbone
and services icon or branch.

2 Select the Configure icon or Configuration Assistant from the ATMvLAN
menu.

The Backbone and Services window is displayed as in Figure 4-5.
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Figure 4-5 The Backbone and Services Window



To setup LECS priority:

Make sure the LECS with on the B* switch is the first one in the list. If
not, change the order using the middle mouse button.

Click Apply.

This applies the two active LECS addresses to each switch. The LECS on
switch B* is the primary one.

To setup the LECS database for LES/BUS redundancy:

In the second section of the dialog box, set the ELAN ID for
Admin/Default VLAN using the appropriate toggles.

Be certain to select ELANID_O from switch A.

Select the primary ELAN ID. This should be same ELAN ID as the one
selected for the Admin VLAN above.

Select the backup ELAN ID using the backup toggle The backup ELANID
should be the elanID_0 from switch B. You will notice in the window that
shows the database, an additional entry with ELANID_O and the two LES
addresses.

Add this entry to the database using the Add button.
If you don't see it in the window, scroll down to check.

5 Select the primary ELANID_1 (for bridge 1) from switch B.
6 Select the backup for ELAN ID_1 from switch A.
7 Add these entries to the database by clicking Add.

The setup consists of two ELANS each backed-up with a LES from the
other CoreBuilder.

In this example, the primary LES/BUS is running on switch B for bridge 1,
and the backup is on switch A. The primary LES /BUS for the admin ELAN
is running on switch A and the backup is on switch B.

Click Apply to have the database modified.

A confirmation box is displayed indicating that the changed have been
applied to both switches.

In the bottom section of the dialog box toggle on Report and Activate
and click Apply.
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At this stage, the “LANE Monitor” tracks LES/BUS failure and activates
redundancy if there is a failure of primary LES.

Bridge 0’s LES/BUS is on CoreBuilder 7000 A and its backup is on
CoreBuilder 7000 B.

Bridge 1's LES/BUS is on CoreBuilder 7000 B and its backup on
CoreBuilder 7000 A. Both switches have LECS databases and each LECS
database has the admin ELAN pointing to switch A LES/BUS ELAN_ID.

Following this procedure, check all the above steps once again. Try to
achieve an intuitive understanding of the network.

If you power-off Switch B, (you have taken down bridge 1's LES/BUS), the
NMS realizes that the primary LES for bridge 1 runs on the switch that
failed and reports it. It then moves the pointer in the LECS database
running on switch A to the backup LES/BUS for bridge 1. All the
segments from bridge 1 move the backup ELAN. This takes a few minutes
for adjustment.

You will first notice that the LECs for bridge 1 on both the edge devices
are in a fatal state. They are then are recovered using the backup LES/BUS
on the switch A.

This example effectively demonstrates both LES/BUS and LECS recovery.

LECS Recovery

While selecting the LECS, the primary LECS was set to switch B. When
switch B failed, the LECs were pointed to switch A’s LECS (the second one
in the list) by the CoreBuilder 7000 automatically.

How to Move the “admin” ELAN LES/BUS Pair from One
CoreBuilder 7000 to Another.

If you want to move the “admin’ ELAN LES/BUS pair from one
CoreBuilder 7000 to another, perform the following steps:

In the Backbone and Services Configuration window, change the
“admin” alias mapping to a new LES/ELAN-ID and select Apply.

This changes the ““admin” LES in all of the LECS databases in one step.
Reset the CoreBuilder 7000 with the old *““admin’ LES.

This step releases all the connections (LECs) from the old “admin”
LES/BUS pair.



All the LECs join the new ““admin” ELAN since the LECS points them to
the new *““admin’” LES.

It takes approximately 15 seconds to update the LECSs via Transcend
Management Software. It takes about two minutes to reboot the switch
with the old LES, and about five to fifteen minutes for all the LECs to join
the new LES.

Quick LANE Redundancy

Quick LANE Redundancy performs automatic LANE redundancy, however,
it differs in the conditions that are used to trigger and activate the
LES/BUS pair redundancy.

Automatic LANE Redundancy is activated when the following conditions
are met:

= One LES/BUS is in critical state (red)

= All of the attached LECs are in critical state

= Alllinks to the CoreBuilder are disconnected

« The CoreBuilder is in critical state

Quick LANE Redundancy is activated when the following conditions are
met:

» One LES/BUS is in critical state (red)

= At least one attached LEC is reported in critical state

« The CoreBuilder is in critical state

To enable Quick LANE Redundancy, toggle on the Redundancy mode
button in the Backbone and Services Configuration Assistant window.

Configuring VLAN
Aliases and Colors

ig

To make it easier to identify and work with VLANs on the ATM and VLAN
Manager, the VLANSs can be given application-oriented names or aliases
(such as engineering, marketing, etc.) and colors to distinguish them on
the device displays.

These aliases are local to the management station and are not reflected in
the LECS database in the ATM switches.



4-22

CHAPTER 4: NETWORK CONFIGURATION TASKS

The following steps listed below illustrate the VLAN alias and color setup.
This procedure is common for both ATM-based VLANSs as well as
non-ATM VLAN alias setup.

From the Root window select the Virtual LANs icon and then from the
ATMVLAN menu select Configuration Assistant

or

in the Topology Browser select a Virtual LANs component and then select
the Configure icon.

The Virtual LANs VLAN Configuration Assistant for the VLAN Aliases and
Colors dialog box is displayed as in Figure 4-6. For ATM-based VLANs the
VLAN ID is the ELAN ID; for non ATM-based VLANSs, the VLAN ID is the
Work Group number.

For CoreBuilder 2500/6000 VLANSs, the VLAN ID is the VLAN name given
by the user.
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Figure 4-6 Virtual LANs Configuration Assistant for Aliases and Colors
The VLAN Names field lists all the VLANs that have been defined in the
NMS.

Select a VLAN ID from the VLAN ID cascade and enter a user-friendly
name in the entry field.

Select a color using the color option button.

4 Click Add.

The name is added to the list.



5 Click Apply to update the database.

ig

If you do not click Apply, none of your changes are entered into the
database.

Before you begin changing/moving VLANSs in the network, you must
define the admin and default VLANSs using this option.

Select the ELAN that the admin VLAN is using. Enter the “admin” in the
entry field and click Add and then click Apply.

Retaining VLAN Aliases and Colors
You can retain VLAN aliases and colors for subsequent installations.

To save the colors save the file:
\TranscendNT\ATMvLAN\runtime\dat\VnRgb.dat

After you reinstall the ATMVLAN Management application, restore the
saved file to the original directory.

VLAN Aliases cannot be added to the LECS database from the Backbone
and Services Configuration window. The LECS database uses ELAN IDs
only. Aliases have significance in the local management station only.

Viewing the VLAN Aliases and Colors Database

You can also view and search all the parameters in the VLAN Aliases and
Colors database using the Locator Tool.

Do not use this window to modify the database and ignore the Type field
in the display section.

To use the Locator Tool to view the VLAN Aliases and Colors database:

1 Select the Locator Tool.
2 Select the VLAN Aliases and Colors tab. See Figure 4-7.
3 Select Search to display all the parameters in the database.

The parameters are displayed.
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To conduct a search based on a specified parameter.
1 Select the parameter from the Search Field.
2 Enter the search string (may be a partial value) in the Value field.
3 Select Search.
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Figure 4-7 Locator Tool VLAN Aliases and Colors
Configuring This section describes the implementation of Policy based VLAN auto-

Policy-based VLAN
Auto-configuration

configuration in ATM based VLAN environments.

Policy based VLAN auto-configuration deals with VLAN configuration
automation based on pre-defined policy or criteria. VLANs are logical
associations of ports in the network based on users and services that are
grouped together as a layer 2 broadcast domain.

The policy dictates the method of creating a logical association. The
policy can be defined to automatically configure VLANs based on users’
MAC addresses and user/server subnet (layer 3) IDs. Policy-based



Automatic
Configuration of
VLANs and Network
Security

VLAN Server and
Automatic VLAN
Configuration

auto-configuration can be extended to include protocol-based VLAN
auto-configuration and application-based VLAN auto-configuration.

One of the most important considerations in automatic VLAN
configuration is network security. Network administrators must have
complete control over how known users access and use the network. In
addition to this, administrators must also have complete control over who
accesses the network and the times and locations where the network was
accessed from. Network intrusions must be detectable and dealt with
automatically.

When devices are setup for auto configuration based on a policy, all
unused ports, or ports whose link status is down, are automatically
placed in the default VLAN. The ports are moved out of the default VLAN
only when a recognized endstation or user connects to a port. This
ensures that unknown users do not have access to all VLANSs in the
network. The default VLAN can be secured by not enabling any network
services within this VLAN, as well as not as connecting the default VLAN
to the rest of the routed network.

The VLAN server is a parameter database or repository that holds the
VLAN mapping information. The VLAN Server is an important component
of the VLAN auto-configuration system. Devices that support VLAN
auto-configuration query the VLAN Server to resolve the VLAN mapping
information based on a pre-defined policy or criteria. For example:
Devices that enforce the MAC address based automatic VLAN
configuration policy query the VLAN server to resolve MAC address to
VLAN mapping. The VLAN Server may contain VLAN mapping
information based on MAC address, IP subnet, Protocol type etc.,
depending on what policies are enforced on the network

There are two types of VLAN servers currently implemented:

1 Stand-alone NT based VLAN Server.

Integrated TEM/Unix or TEM/NT based VLAN server.
Stand-alone NT based VLAN Server.

This server is used by SuperStack Il Switch1000/3000 and Desktop
switches when configured in AutoSelect Mode, to execute automatic
VLAN configuration based on MAC addresses. See the description of
AutoSelect Mode VLAN configuration.
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Integrated TEM/Unix or TEM/NT Based VLAN Server.

This server is integrated with the TEM application and is use in policy-
based VLANSs. Policy-based VLANSs are supported on ATM-based switches
such as the CoreBuilder 7000/7x00, SuperStack Il Switch 1000 with ATM
downlink, Switch 3000 with ATM downlink and Desktop Switch with
ATM downlink.

The integrated VLAN server can be populated using the BuildvDB tool in
the ATMVLAN Tool bar and can be viewed and modified using the
MACVdb Tool.

Auto-select VLAN Configuration. The following describes how to
configure the auto-select mode on Ethernet and Fast Ethernet based
networks.

Auto-select mode allows devices to automatically partition their ports into
VLANSs based on the MAC address of the endstation attached to the port.
This mode is supported on SuperStack Il Switch 1000, SuperStack |I
Switch 3000 and Desktop Switch.

Please refer to the SuperStack Il Switch 1000 and 3000 Configuration
Manual for a description of this feature.

When Auto-select mode is enabled, these switches communicate with
the stand-alone VLAN Server to determine the MAC address to VLAN
association. If a MAC address to VLAN association is not found in the
VLAN server member table, the VLAN server returns a default VLAN ID
(VLAN 1) and then enters the new MAC address into its member
database and associates this new MAC address with VLAN 1.

To move a MAC addresses from one VLAN to another, or to change a
MAC address to VLAN association in the VLAN Server member database,
the VLAN server database must be modified using the Locator tool. By
modifying the mapping between a MAC address and the corresponding
VLAN, you can indirectly move segments on the devices that are in the
“AutoSelect” mode to various VLANs based on the MAC address to
VLAN association.

The stand-alone VLAN Server database can be viewed and modified using
the VLAN Server Member tab under the Locator Tool. The VLAN Server
Scalar Parameters Tool under in the Locator is used to configure the



Configuring MAC-
based VLAN
Auto-configuration
Policy

ATMVLAN application to recognize and communicate with an NT based
stand-alone VLAN Server (IP address and SNMP community string).

This section describes how to configure devices to enforce the
MAC-based policy.

When a device is configured for the MAC-based policy, it automatically
partitions its ports into VLANSs, based on the MAC address of the
endstation that is attached to its ports. When an endstation attaches to a
device, it automatically configures the endstation’s port to the correct
VLAN based on the endstation’s MAC address. The device queries the
VLAN Server to determine the correct VLAN associated with the
endstation MAC address.

Under Auto-configuration mode, only one endstation is allowed to be
connected to a device port.

The following steps describe the configuration of MAC based Policy on
devices:

Define two aliases; “unknown” and “default” using the ATM and VLAN
Aliases and Colors Configuration Tool. See “Configuring VLAN Aliases
and Colors” on page 4-21.

Populate the Integrated VLAN Server database with MAC address to
VLAN mapping information. See “Populate the Integrated VLAN Server
database with MAC address to VLAN mapping information using Build
UDB” on page 4-27

Apply the MAC-based VLAN auto-configuration to the devices. See
“Apply the MAC-based VLAN Auto-configuration to the Devices” on
page 4-31.

Verify that automatic VLAN auto-configuration is activated.

Populate the Integrated VLAN Server database with MAC address
to VLAN mapping information using Build UDB

1 Connect a PC to any port on an edge device.

Generate some traffic from this PC so that its MAC address is learned by
the device.

Select the Users icon (from the ATMVLAN Toolbar).
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Build UDB Tool

4 Using the Build UDB tool, do an inventory of the network so that the

MAC address location (device/port/VLAN) where this PC is attached to is
learned and stored.

The Build UDB tool can be configured to do an MAC address inventory of
the entire network or a selected subset of devices on the network.

To open the Build UDB Tool, see Figure 4-8, start the tool from the by
selecting the Users icon. The Build UDB Tool lists all the edge devices in
the network.

To use the Build UDB Tool:

Select the Select All button to select all the listed devices or highlight the
devices that you want include. All the selected devices will be included in
building the current devices database. The devices are sequentially
added/updated to any previous database builds that were performed.

For multiple device selection, press Ctrl and the left mouse button.

Select the Start button in the Build UDB. Once started, the Build UDB Tool
gueries all the selected edge devices and collects MAC address
information.

Once the Build UDB Tool finishes a sweep of the network, you can verify
the location of the endstation MAC addresses by using the MACvVDB tab
in the Locator Tool.
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Figure 4-8 The Build UDB Tool
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Configuring and
Using the MACvDB

The MACVDB is used to perform the following two functions:

1 Finding a MAC address in the network.

Mapping MAC addresses to VLANSs.

Finding a MAC Address

Locating a MAC address allows the network administrator to see which
switch the endstation is attached to.

Mapping a MAC Address to a VLAN

This feature is used by the MAC-based policy to determine the MAC
address to VLAN mapping. By changing the MACvDB you can redirect
MAC addresses to different VLANs. The MACVDB, see Figure 4-9, is
populated automatically when you initiate the BuildvDB Tool. You use the
Locator Tool to search, configure and modify parameters for the
MAC-based policies.

Searching the MACvDB

To search the MACvDB using the Locator Tool:

1 Click on the Locator Tool icon.
2 Select the MACVDB tab.

To search the MACvDB you may select one of the following search
strings:

= Segment

= Switch

= MAC Address
= IP Address

To search the databases:

From the Search Field cascade, select the type of search string you want
to locate in the database.

In the Value field enter a partial value of the search string you are
searching for and click Search.

A search progress bar is displayed indicating the number of matches
found for your search query.
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A W N P

The Search History indicates the searches you have perform thus far.
To display the contents of your database:
= Select Search.

Once the parameters appear in the display section you can edit or modify
the database.

It is recommended that you use the Edit mode if you are going to perform
extensive modification to the database.

Modifying the MACvDB
To modify the MACVDB database:

Click Edit.

Select a row in the display.

Use the bottom portion of the dialog box to edit parameters.
Select Replace.

A warning message appears if you try to modify the database while in
Search mode.

To add or delete database parameters:

1 Select a row.
2 Click Add or Delete.
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Figure 4-9 The Locator Tool/MACVDB Tab

Apply the MAC-based To apply the MAC-based auto-configuration policy to the devices you
VLAN have to move the devices into the MAC-based policy.
Auto-configuration
to the Devices To move the devices into the MAC-based policy:
1 Select the edge device in the ATMvVLAN Devices map

2 Select the MacBaseVlanPolicy icon in the ATMVLAN Policies map and then
select the VLAN Move icon or the Move option from the ATMVLAN menu.

The policy icon turns yellow, indicating that there are devices in the policy.
To remove a device from a policy:

1 Select the device in the policy map and then select the NullPolicy icon.
2 Select the Move icon or the Move option from the ATMVLAN menu.
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This removes the device from the policy.

Once a device or port is put into a policy, all open/unused ports are
automatically placed into the default VLAN. You will notice a message on
the NMS screen saying that VLAN move has taken place.

Verify that Automatic VLAN Auto-configuration is Activated.

Move the PC from the port on the SuperStack Il Switch 2700 to another
open port on another SuperStack Il 2700 (or another port on the same
2700) or SuperStack Il 1000 (the destination device must also be assigned
to the policy) and generate a few pings.

A message is displayed that the VLAN move completed successfully.

Open the front panel view of the device and then check the VLAN colors.
The port on the device where the PC is connected is now configured into
the VLAN that its MAC address was mapped to. This VLAN configuration
change may take a few seconds to be reflected in VLAN maps.

Configuring IP
Subnet-based VLAN
Auto-configuration

This section describes the IP Subnet-based VLAN auto-configuration
policy. If an endstation IP subnet address is pre-mapped to a VLAN, then
the edge devices configured for this policy will automatically configure
the correct VLAN on the port that this station attaches based on the
endstation’s IP Subnet Address.

How Does IP Subnet-based VLAN Auto-configuration Compare to
DHCP?

When DHCP is enabled in the network, roving endstations can
automatically query for and get an IP address and network access
dynamically. The access to the network may not be optimal as the
endstation is configured into the subnet of the building or location. Its
services may be in another subnet or building. With IP Subnet-based
VLANS, roving endstations can maintain their IP address and
VLAN/Subnet and get optimal performance connectivity (layer 2
connectivity) to their services (file services, print services).



Configuring and
Modifying the Subnet
vDB

To configure of IP Subnet -based policy on devices you have to populate
the VLAN server database with IP-Subnet to VLAN mapping information.

1 Start the Locator Tool and select the SubnetVvdb tab,.

Click on the Search button to bring up the Subnet vDB inventory
database. See ““Searching the Subnet vDB”’ on page 4-33.

Modify the Subnet vDB to map IP subnets to VLANs. See “Modifying the
Subnet” on page 4-34.

Move the devices into the IP Subnet-based policy. See See “Moving
Devices into the IP Subnet-based Policy”” on page 4-35.

Verify that automatic IP Subnet-based VLAN auto-configuration is
activated.

The Subnet vDB, see Figure 4-10, allows you to configure the Subnet
based policies.

Searching the Subnet vDB

To search the Subnet vDB using the Locator Tool:

1 Click on the Locator Tool icon.
2 Select the Subnet vDB tab.

To search the Subnet vDB you may select one of the following search
strings:

= Protocol

= Subnet Address
» Mask

= VLAN Name

From the Search Field cascade, select the type of search string you want
to locate in the database.

In the Value field enter a partial value of the search string you are
searching for and click Search.

A search progress bar is displayed indicating the number of matches
found for your search query.

The Search History indicates the searches you have perform thus far.

To display the contents of your database:
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= Select Search.

Once the parameters appear in the display section you can edit or modify
the database.

Modifying the Subnet
To modify the SubnetvDB:

1 Select a row.
2 Use the bottom portion of the dialog box to edit parameters.
3 Select Replace.

A warning message appears if you try to modify the database while in
Search mode.

To add or delete database parameters:
1 Select a row.
2 Edit the parameters.
3 Click Add or Delete.
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A warning message appears.
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Figure 4-10 The Locator Tool Subnet vDB
Moving Devices into the IP Subnet-based Policy
To move the devices into the IP Subnet-based policy:

1 Select the edge device in the ATMvLAN Devices map

2 Select the IP Subnet-based VLAN Policy icon in the ATMVLAN Policies
map.

3 Select the VLAN Move icon or the Move option from the ATMVLAN
menu.

The policy icon turns yellow, indicating that there are devices in the policy.



4-36  CHAPTER 4. NETWORK CONFIGURATION TASKS

Configuring
AutoSelect VLANs on
Ethernet and
FastEthernet based
Networks

Verify that Automatic IP Subnet-based VLAN Auto-configuration
Activated.

Move the PC from the port on the SuperStack Il Switch 2700 to another
open port on another SuperStack Il 2700 (or another port on the same
2700) The destination device/port must also be assigned to the policy
also. Generate a few pings to an unknown destination so that a
broadcast ARP is generated.

The first few packets must be a broadcast so that the switch can capture
the information about the endstation. Switch 2700 and CoreBuilder 7x00
cannot capture Unicast packets. The ping must be to an unknown
destination so that an ARP broadcast is continuously generated.

A message is displayed that the VLAN move completed successfully.

If the PC’s IP subnet is mapped to VLAN elanxx_x, when the PC is
connected to a switch and it generates a broadcast, the device
automatically configures the port to the VLAN that is mapped to PC’s IP
Subnet address.

Open the front panel view of the device and then check the VLAN colors.
The port on the device where the PC is connected is now configured into
the VLAN that its MAC address was mapped to. This VLAN configuration
change may take a few seconds to be reflected in VLAN maps.

Devices such as SuperStack Il Switch 1000, 3000, and Desktop Switches,
can be configured to automatically partition their ports into VLANs based
on the MAC addresses of the endstations that are attached to them. The
mode of operation on these devices is called the AutoSelect Mode.

The behavior of devices when configured in the AutoSelect Mode is
similar to policy-based VLAN auto-configuration based on MAC
addresses, although using policies applies only to ATM edge devices.
Non-ATM devices cannot be configured based on policies.

When devices are configured to AutoSelect Mode, an external VLAN
Server must be enabled in the network in order for the devices to query
and retrieve MAC address to VLAN mapping information. This database
can be populated using the VLAN Server Member Table Tool under the
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Locator Tool. The external VLAN server is also populated automatically
when devices register their MAC addresses in it. By default all MAC
addresses that are automatically registered are associated with VLAN 1
(default VLAN).

Configuring and Modifying the External VLAN Server Scalar
Parameters

The VLAN Server Scalar Parameters, see Figure 4-11, allows you to view
configure the ATMVLAN application to recognize the VLAN server (IP
address and SNMP Community String) as well as configure the VLAN
server’s Scalar parameters.

The External VLAN server’s IP address and SNMP community string may
also be setup using a Configuration Assistant.

To setup the External VLAN server IP address and SNMP community
string:

= Select a work group VLAN icon in the VLAN map and then select the
Configuration Assistant option in the Transcend -> ATMVLAN menu.
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Searching the VLAN Server Scalar Parameters
To search the VLAN Server Scalar Parameters using the Locator Tool:

1 Click on the Locator Tool icon.

2 Select the VLAN Server Scalar Parameters.

g | (X ¥ b
A 2 Wik Sanasr Vien Sens
R Vi Subnetvdh | DeeceDmiabase | LCTSESEL e Prametu
P Address (199,201
Gammumity Name [ pubse

Coownt of dafined VAN BTterfaoes
I the suTVlanTable -

Index of the most reqent entry
N the SwrChangeTabbe :

Maximues nusber of antries
whioh can ba stored
by tha swrChangeTabse :

Interval in sesonds at which
2l VLAM Chents must poll
the VLAN Server:

TS

Chose

EE ek

Logging requests
mad e by CREns © I

Figure 4-11 The Locator Tool VLAN Server Scalar Parameters

Configuring and  The VLAN Server Member Table, see Figure 4-12, allows you to view and
Modifying the VLAN  modify the External VLAN Server database.
Server Member Table
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Searching the VLAN Server Member Table
To search the VLAN Server Member Table using the Locator Tool:

1 Click on the Locator Tool icon.
2 Select the VLAN Member Table tab.

3 Select the Get Button to download the VLAN Server database to a local
database.

Use the Search Button to find and MAC address.

Use Edit Button to change its VLAN mapping.

Use Apply Button to save it locally in the local database

Use Set Button to upload the modified database to the VLAN Server.
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Figure 4-12 The Locator Tool VLAN Server Member Table
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Configuring or
Viewing
Administrative
Status of ATM and
VLAN Components

To view or configure administrative status select the icon in the
management maps and then select Configuration Assistant from the
ATMVLAN menu

or

select the device component in the Topology Browser and then use the
Configure icon to display the configuration dialog box.

The LEC Configuration Parameter and Status Assistant

The LEC Configuration dialog box, see Figure 4-13, shows the
configuration, time-out, and status parameters of the LEC.

To access the LEC Configuration dialog box:

From one of the ATM and VLAN management maps, select an LEC icon,
or in the LAN Emulation branch in the Topology Browser, select an LEC.

2 Select the Configure icon.
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Table 4-1 Configuration Parameters

Parameters Meaning

Config Mode Indicates whether this LAN Emulation Client
should auto-configure the next time it is
restarted.

LAN Type The data frame format which this client will
use the next time it returns to the Initial
State.

Dat Frame The maximum data frame size which this
client will use the next time it returns to the
Initial State.

ELAN Name The ELAN Name which this client will use the
next time it returns to the Initial State.

LES Address The LAN Emulation Server which this client

will use the next time it is started in Manual
Configuration Mode.

Table 4-2 LEC Timeout Parameters

Parameters Meaning

Control Time-out Time-out period used for timing out most
request/response control frame interactions.

Signaling Time-out Time-out period used for timing out attempts
to create VC.

Ageing Time The maximum time that an LE Client will
maintain an entry in its LE_ARP cache in the
absence of a verification of that relationship.

Table 4-3 LEC Status Parameters

Parameters Meaning

Admin Status The desired state of the LAN Emulation
Client.

LEC State The current state of the LAN Emulation
Client.

Last Fail Status code from the last failed Configure

response or Join response.

Fail State The state this client was in when it updated
the lecLastFailureRespCode.
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Table 4-4 LEC Configuration Window Actions

Parameters Meaning

LEC ID LE Client Identifier. Assigned by LE Server in
the Join phase.

LE Server Parameters & Status Configuration Assistant

The LE Server Parameters & Status Window is displayed in Figure 4-14. It
shows the Parameters and Status Parameters o the selected LES.
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Figure 4-14 LES Parameters and Status Configuration Assistant
To access the window:

= From Backbone and Services window, select an LEServer icon and then
select the Configure icon.

« From the VN_Name window, select an LES icon and then select the
Configure icon.
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Table 4-5 LES Parameters

Parameters

Meaning

Description

The ELAN Name of this LES.

Type

Either Ethernet or Token-Ring Bus.

MTU

The size of the largest packet which can be
sent/received to/from the LES, specified in
octets.

Speed

An estimate of the LES's current bandwidth

Address

The LES's ATM address.

The LES Status is:
Table 4-6 LES Status

Status Meaning Values
Admin Status The desired state of the Enabled
LES. Disabled
Test
Oper Status The current operational Up
state of the LES. Down
Testing
Unknown
Dormant

Table 4-7 Window Actions:

To Select Click

Change administration status of LES Admin Status option Apply
menu

Close window Close
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Ethernet Port Parameters & Status Configuration Assistant

The window shows the Port Parameters and the Port Status of the
selected Ethernet port.

Ethernet Port Parameters & Status Window is displayed in Figure 4-15.
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Figure 4-15 The LsEthPort Parameters Configuration Assistant
To access the LsEthPort Configuration Assistant window:

= In the ATM Switch window, from Switch x.x.x.x, select an Ethernet
port and then with the device view displayed, select Configuration
Assistant from the ATMvLAN Toolbar.

« From an ATM SuperStack, select an Ethernet port on a SuperStack Il
Switch 2700 module and then with the device view displayed, select
Configuration Assistant from the ATMVLAN Toolbar.

= From the CoreBuilder 7000 Front Panel, select an Ethernet port on a
7200 Card and then with the device view displayed, select
Configuration Assistant from the ATMVLAN Toolbar.
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The port parameters are:
Table 4-8 Port Parameters

Parameters Meaning

Description A textual string containing information about
the interface, including the name of the
manufacturer, the product name, and the
version of the hardware/software.

Type The type of interface (Ethernet)

MTU The size of the largest packet which can be
sent/received on the interface, specified in
octets.

Speed An estimate of the interface's current
bandwidth in bits per second.

Address The interface's MAC address.

The Port Status is:

Table 4-9 Port Status

Status Meaning Values
Admin Status The desired state of the Enabled
interface. (The port is Disabled
enabled/disabled by Test
software).
Oper Status The current operational Up
state of the interface. Down
Testing
Unknown
Dormant

ATM Port Parameters & Status

ATM Port Parameters & Status Window is displayed in Figure 4-16. It
shows the Port Parameters and the Port Status of the selected ATM port.
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Figure 4-16 LsOc3Portx x Window/ATM Port Parameters and Status
To access the window:

1 From Switch x.x.x.x, select an ATM port or from an ATM SuperStack,
select an ATM port on a SuperStack Il Switch 2700 module.

2 With the device view displayed, select Configuration Assistant from the
ATMVLAN Toolbar.

The port parameters are:

Table 4-10 Port Parameters

Parameters Meaning

Description A textual string containing information about
the interface, including the name of the
manufacturer, the product name, and the
version of the hardware/software.

Type The type of interface (ATM).
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Table 4-10 Port Parameters

Parameters Meaning

MTU The size of the largest packet which can be
sent/received on the interface, specified in
octets.

Speed An estimate of the interface's current
bandwidth in bits per second.

Address The interface's ATM address.

The port status is:

Table 4-11 Port Status

Status Meaning Values
Admin Status The desired state of the Enabled
interface. (The port is Disabled
enabled/disabled by Test
software).
Oper Status The current operational Up
state of the interface. Down
Testing
Unknown
Dormant

Table 4-12 Window Actions:

To: Select: Click
Change administration status of Admin Status option Apply
port menu

Close window Close

SuperStack Il Switch 2700 Parameter and Status Information

The SuperStack Il Switch 2700 Parameter and Status Information window
is displayed in Figure 4-17. The window shows system and chassis
Information. This information is read-only.
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Figure 4-17 The LinkSwitch/SuperStack li Switch 2700 Configuration Assistant

To access the LinkSwitch/SuperStack Il Switch 2700 Configuration
Assistant:

= From ATMSwitchx.x.x.x, select SuperStack Il Switch 2700 icon and
then with the device view displayed, select Configuration Assistant
from the ATMVLAN menu.

= From ATM devices, select SuperStack Il Switch 2700 icon and then
with the device view displayed, select Configuration Assistant from
the ATMVLAN menu.

« From an ATM SuperStack Il Switch 2700 icons, select SuperStack |l
Switch 2700 icon and then with the device view displayed, select
Configuration Assistant from the ATMvLAN menu.

« From the LANE User icon, select SuperStack Il Switch 2700 icon and
then with the device view displayed, select Configuration Assistant
from the ATMVLAN menu.

« From a Switch x.x.x.x, select “System patch” and then with the device
view displayed, select Configuration Assistant from the ATMvLAN
menu.
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= From an ATM SuperStack, select “System patch” for a SuperStack |l
Switch 2700 module and then with the device view displayed, select
Configuration Assistant from the ATMvVLAN menu.

The system information is:

Table 4-13  System Information

Parameters Meaning

Description A textual description of the SuperStack |I
Switch 2700 module.

Sys Oid System Object Id. Vendor identification of the
SuperStack Il Switch 2700 module.

Contact The textual identification of the contact

person for this SuperStack Il Switch 2700
module, with information on how to contact
this person.

Location The physical location of this SuperStack Il
Switch 2700 module.

The chassis information is:
Table 4-14 Chassis Information

Status Meaning

Chassis Type An authoritative identification of the SuperStack |I
Switch 2700 module.

Serial Number The serial number of this SuperStack Il Switch 2700
module.

Table 4-15 Window Actions:

To: Select: Click

Close window Close

CoreBuilder 7000 Module ATM Port Parameters & Status

The CoreBuilder 7000 Module ATM Port Parameters & Status Window is
displayed in Figure 4-18. It shows the Port Parameters and the Port Status
of the selected CoreBuilder 7000 module port.
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Figure 4-18 CoreBuilder Module ATM Port Parameters & Status
To access the window:

From a CoreBuilder.x.x.x.x, select an ATM port and then with the device
view displayed, select Configuration Assistant from the ATMVLAN menu.

The Port Parameters are:

Table 4-16 Port Parameters

Parameters Meaning

Description A textual string containing information about
the interface, including the name of the
manufacturer, the product name, and the
version of the hardware/software.

Type The type of interface (ATM).

MTU The size of the largest packet which can be
sent/received on the interface, specified in
octets.
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Table 4-16 Port Parameters

Parameters Meaning

Speed An estimate of the interface's current
bandwidth in bits per second.

Address The interface's ATM address.

The Port Status is:

Table 4-17 Port Status

Status Meaning Values
Admin Status The desired state of the Enabled
interface. (The port is Disabled
enabled/disabled by Test
software).
Oper Status The current operational Up
state of the interface. Down
Testing
Unknown
Dormant

Table 4-18 Window Actions:

To: Select: Click

Change administration Admin Status option menu  Apply
status of port

Close window Close
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CoreBuilder 7000 Module Parameter and Status Information

CoreBuilder 7000 Module Parameter and Status Information Window is
displayed in Figure 4-19. It shows system and chassis information. This
information is read-only.

b

Eyshern Inforrmabion

dessiginn

Chagsais Infarrmalion

Chasis Typs

B i M LiFraas

Apply |[Cloze  Help

Figure 4-19 CoreBuilder Parameter and Status Configuration Assistant
To access the window:

»« From CoreBuilderx.x.x.x, select IP Address Label and then with the
device view displayed, select Configuration Assistant from the
ATMVLAN menu.

» From ATMSwitchx.x.x.x, select the CoreBuilder 7000 module icon and
then with the device view displayed, select Configuration Assistant
from the ATMVLAN menu.

= From ATM devices, select the CoreBuilder 7000 module icon and then
with the device view displayed, select Configuration Assistant from
the ATMVLAN menu.
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The System Information is:
Table 4-19 System Information

Parameters Meaning

Description A textual description of the SuperStack |l
Switch 2700 module.

Sys Oid System Object Id. Vendor identification of the
CoreBuilder 7000 module.

Contact The textual identification of the contact

person for this CoreBuilder 7000 module,
with information on how to contact this

person.
Location The physical location of this CoreBuilder
7000 module.
The Chassis Information is:
Table 4-20 Chassis Information
Status Meaning
Chassis Type An authoritative identification of the CoreBuilder 7000
module.
Serial Number The serial number of this CoreBuilder 7000 module.
Table 4-21 Window Actions:
To: Select: Click

Close Window Close
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CoreBuilder 7000 Module Switch Board Parameters & Status

CoreBuilder 7000 Module.x.x.x.x Parameters & Status Window is
displayed in. It shows the Module Parameters and the Status of a

CoreBuilder 7000 Module.
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Figure 4-20 The CB Switch Module Parameters and Status Configuration
Assistant
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To access the window:

= From a CoreBuilder.x.x.x.x, select Switch Board Module and then with
the device view displayed, select Configuration Assistant from the
ATMVLAN menu.

The Module Parameters are:
Table 4-22 Module Parameters

Parameters Meaning

Location Module slot number starting from 1.
Counting starts at the upper-most module.

Type An authoritative identification of the type of
physical Module in this physical location.
(Switch Board).

S/W Version A textual description of the version/revision
for this Module’s software.

H/W Version A textual description of the version/revision
for this Module’s hardware.

Serial The serial number of the physical Module

present in this physical location.

The Module Status is:
Table 4-23 Module Status

Status

Meaning

Values

Admin Status

The desired state of the
module.

None
Enabled
Disabled
Reset
Load
Test

Oper Status

The current operational
state of the module.

Other

Invalid

Test

Oper

Reset
Warning
nonFatalError
fatalError

Table 4-24 Window Actions:

To:

Select:

Click:

Change administration status of

module

Admin Status option menu Apply



Table 4-24 Window Actions:

To: Select: Click:
Close window Close

Configuring PVCs

You can configure Permanent Virtual Channels between ATM devices.
To configure Permanent Virtual Channels between ATM devices:

Locate the ATM devices that are to be connected. See “Locate the ATM
Devices” on page 4-57.

Display existing VCs between ATM devices. See “Display Existing VCs” on
page 4-57.

Establish new Permanent Virtual Channels. See “Establishing Permanent
Virtual Channels” on page 4-57.

Locate the ATM Devices

To locate the two ATM devices, proceed as follows:

1 Select an ATM Network Map.

Select two ATM switches for which the PVC is to be established.
Display Existing VCs

To display existing VCs between two ATM devices:

1 Select the two ATM switches for which the PVC is to be established.
2 Select the Path icon or Path Assistant from the ATMVLAN menu.

The ATM Path Assistant window displayed showing the existing VCs
between the two ATM devices.

Establishing Permanent Virtual Channels
To establish a PVC between the two ATM devices:

1 In the ATM Path Assistant window select VC -> Add PVC.

In the VPI-VCI field enter the Virtual Path Identifier/Virtual Channel
Identifier for the new PVC.

Enter the VPI and VCI with a space between them.
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VPl is in the range 0:4 and VCI in the range 64:511
The new PVC is displayed in the window.

Pinpointing Channel Congestion

If you want to locate channel congestion, you can examine the ATM
Paths using the VC Path Assistant. Congestion can be pinpointed to the
individual links of the channel by means of the VC Path Statistics window.

To display the VC Path Statistics window for a particular channel from the
VC Path Assistant window select the channel and then select Statistics
from the VC menu.

The VC Path Statistics window appears as in Figure 4-21.
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Figure 4-21 VC Path Statistics

The VC Statistics window shows the traffic through each link of the trail
in a bar graph. If the traffic is normal, the height of each bar should be
approximately the same. However if the height of successive bars in the
direction of the flow decreases sharply at a certain link, then that
particular link is the source of congestion on the trail.

Virtual Channels You can easily examine Virtual Channels in the Network-Network
Across NNI and UNI  Interface (NNI) and User-Network Interface (UNI) even if the icons are
Interfaces located on two different Switch Domain windows.
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To examine Virtual Channels:

1 In the ATM Network window, double click on an ATM Switch Domain
and select Zoom Physical from the ATMVLAN menu.
The Virtual Path window is displayed as shown in Figure 4-22.

2 Select any two ATM devices in the ATM Switch window.

3 Select the Path icon or Path Assistant from the ATMVLAN menu.

The Path ATM Switch window is displayed showing all paths between the
two ATM devices.
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Figure 4-22 The Virtual Path window
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NETWORK MODIFICATION TASKS

This chapter describes how to perform the following ATM and VLAN
Management network modification tasks.

The following topics are described:

= VLAN Moves
« Enabling and Disabling Ports
=« Manual LECS Database Modification

VLAN Moves There are two types of VLAN moves:
« moving Ethernet segments between VLANSs

»« moving Ethernet segments or devices between policies

Moving Ethernet  Frequently, it is necessary to move, or reassign one or more Ethernet
Segments Between Segments (Ethernet ports) from one VLAN to another VLAN. This
VLANs operation is required when a port which was previously used by a
member of one group is to be used by a member of a different group.
One example might be transferring a port from a member of the
Engineering VLAN to a member of the Marketing VLAN. Non ATM-based
VLANS are moved in exactly the same way as ATM-based VLANSs.
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Several methods are provided for moving Ethernet segments between
VLANS. They are detailed in the following sections.

= Using the VLAN Move Operation
« Drag-and-Drop Ethernet Segments Between VLAN Windows.

= For the SuperStack Il Switch 2700 or CoreBuilder with 7x00 card, see
Drag-and-Drop on Front Panel Window.

= Automatic VLAN Moves Based on Policies.

= Moving Ports Between Protocol-based VLANS.

The first two methods work on all VLAN types; the others apply to
specific types of VLANs as denoted. With the first method you can
“aggregate” segments to move many segments at once and you can
move segments to different VLANSs at the same time. The second and
third methods are more intuitive and are quicker for moving individual
segments.

Using the VLAN Move Operation

To use the VLAN Move operation:

Select the Ethernet segments to be moved in either the VLAN-name
window or the LANE User window.

Select the destination VLAN in the Virtual LANs window and then from
the ATMVLAN menu select ATMvVLAN Move.

You can locate the Ethernet segment icons by stepping down through
windows. Alternatively, if the segment label is known to you, you can use
the HPOV Locate option. see ““Locating Ethernet Segments Using the
HPOV Locate Option” on page 5-6.
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To locate Ethernet segments:

1 In the Root window, double click on the Virtual LANs icon or highlight the
icon and from the ATMVLAN menu select Zoom Physical. Alternatively,
you can descend through the LAN Emulation windows to the LANE User
window. See ““Using the LAN Emulation Window” on page 5-6.

The Virtual LANs Window is displayed as in Figure 5-1.

e R B (PR e R

i}

| chndwa [Pl s st | aste-Lmprai] &

Figure 5-1 The Virtual LANs window

2 Inthe Virtual LANs window, double click on the source VN-vLAN_name or
WG-name icon, or highlight the icon and then select the Zoom Physical
from the ATMVLAN menu.
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The VN-vLAN_name window appears as in Figure 5-2, with the Ethernet
segments associated with the selected VLAN displayed.
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Figure 5-2 The VN_name window

3 Reposition the VN-VLAN_name window so that it is separate from the
Virtual LANs window.

4 In the VN-vLAN_name window, identify the Ethernet segment icons to be
moved by their IP addresses and port numbers.

The IP Address with the addition of the number of the port to which the

b segment is connected identifies the Ethernet segment. The last number in
the segments icon label indicates the port number. For example, the
following icon label indicates that Ethernet segment 100.0.0.0 is
connected to port 6.

Seg.100.0.0.90.6

5 Select the Ethernet segment icons to be moved.

In the HPOV platform, use CTRL/MB1 for multiple selections. You may
also select a rectangle over an area to enclose multiple Ethernet segment
icons using the drag/MB1 feature.
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The port icons, colored brown, are part of the admin VLAN. These icons
cannot be moved from the admin VLAN to other VLANSs in SuperStack |l
Switch 2700 or CoreBuilder with the 7X00 card units.These ports can be
moved from the admin VLAN to other VLANSs in SuperStack Il Switch
1000/3000 and Desktop Switches.

In the Virtual LANs window, select the destination VLAN.

Be certain to press Ctrl/MB1 when selecting the destination VLAN, so that
Ethernet segments remain selected in the source window.

Select the Path Assistant option from the ATMVLAN menu.

The VLAN Move window is displayed, indicating the destination VLAN
name and device and address of the segment moved.

The Ethernet segments are not moved until the Apply button is pressed.
Meanwhile, the icons of the segments turn yellow. At this point you can
select another set of source and destination icons and select the Move
icon or ATMVLAN Move again. Each time you select the Move option, the
new segments are added to the VLAN Move window. See Figure 5-3.
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Figure 5-3 The VLAN Move window
Repeat steps 5 to 7 until all Ethernet Segments to be moved are listed on
the VLAN Move window.

To execute the move, click Apply in the VLAN Move window. To cancel
the move, close the VLAN Move window.

An information box is displayed for each segment moved successfully.
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Using the LAN Emulation Window

In the Root window, double click on the LAN Emulation icon or highlight
the icon and select the Zoom icon.

Double click on the source LANE User or highlight the icon and select the
Zoom icon.

The LANE User window is displayed with the Ethernet segments
associated with the selected VLAN.

Proceed with step 4 as described in the previous section.

Locating Ethernet Segments Using the HPOV Locate Option

A quick way to locate a specific Ethernet Segment in a large system with
many Ethernet Segments is the Network Management Platform (e.g., HP
OpenView) Locate service.

To use the Locate option:

In an OpenView window, select Locate->Objects->by Symbol_Label.
The Locate by Label dialog box is displayed.

Type in the Ethernet Segment port address and click Apply.

A list of occurrences of the label in all OpenView Windows is displayed.
Highlight the Ethernet segment (port address) you want to locate.

The selected Ethernet segment will be highlighted in the VLAN and/or
LAN Emulation window that is open on your display.

Drag-and-Drop Ethernet Segments Between VLAN Windows

The “Drag-and-Drop” method is also available for moving Ethernet
segments between VLANs. With this method you open both source and
destination VN-VLAN-name windows and drag an Ethernet segment
from the source window and drop it into the destination window.

Perform the following steps to use this method. Refer to the previous
method for details:

Open the source VN-vVLAN_name or WG-name window and locate the
Ethernet segments to be moved by their IP addresses and port numbers.

In the VN-vLAN_name or WG-name window, select the Ethernet segment
icons to be moved.
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In the HPOV platform, use CTRL/MB1for multiple selections or select a
rectangle over an area to enclose multiple Ethernet segment icons using
the drag/MBL1 feature.

Open the destination window. You do not need to select anything.

4 Using the middle mouse button, drag the Ethernet segment from the

source VLAN window to the destination VLAN window and release.
The VLAN Move window is displayed. See Figure 5-3.

Repeat steps 2 to 4 until all Ethernet Segments to be moved are listed on
the VLAN Move Window.

To execute the moves, click Apply in the VLAN Move window. To cancel
the operation close the VLAN Move window.

An information box is displayed for each segment moved successfully.

Drag-and-Drop on Front Panel Window

This method makes it possible to move one or more Ethernet segments
between VLANS using the drag-and-drop technique in a single window.

To use drag-and-drop on the Front Panel window method:

Open either the Superstack Il Switch 2700 or CoreBuilder with 7x00 card
Front Panel window. See Chapter 4 for a description on how to access
these windows.

The front panel of the device containing destination Ethernet ports
(segments) is displayed. See Figure 5-4 for an example of the SuperStack
[l Switch 2700 Front Panel display.

Only VLANs whose names and colors were defined at setup appear on
the front panel VLAN display. Defining VLAN aliases is described
“Configuring VLAN Aliases and Colors™ on page 4-21.
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When you toggle on a VLAN name, the lines underneath the ports
become the alias color of the VLAN, thus making it easier to identify the
ports associated with the VLAN.
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Figure 5-4  SuperStack Il Switch 2700 Front Panel Display

2 Click on the destination Ethernet ports (segments).

You can use the drag/MB1 feature to select a rectangle and enclose
multiple ports. The selected port’s background is displayed in blue. If you
are moving segments to one port only you do not need to perform this
step.

To undo a selection, click on the bottom of the Front Panel Display
window.

3 Using MB2, select the VLAN button on the bottom of the Front Panel and
drag it to the new port number and release (drop).

When selecting the VLAN, a move icon appears, containing a square and
a running figure. Be certain to place the square portion of the icon
directly over the port.

If you drop the destination VLAN on a port which you did not select, the
result will be that the port will be moved along with the selected ports.
The VLAN Move window is displayed.

4 Click Apply.
An information box is displayed for each segment moved successfully.
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Automatic VLAN Moves Based on Policies

In addition to the manual VLAN Move method above, devices can be
setup to automatically configure themselves into VLANs based on
policies. Using this method, ports automatically move between VLANSs.
The changes are dynamically reflected in the VLAN maps. Policy-based
VLAN Auto-configuration is described in detail in Chapter 4.

The VLAN Move method described in ““Moving Ethernet Segments
Between VLANS” on page 5-1 also works for moving ports between
protocol-based VLANSs in the CoreBuilder 2500 with one important
difference. When the source and destination VLAN are not of the same
protocol type, the port will belong to both source and destination VLAN
after the move is complete. It is moved to the destination VLAN but not
removed from the source VLAN. This behavior takes into account the
possibility that one port can belong to several protocol-based VLANs as
long as they are of different types (two different IP VLANSs are considered
to be different types). On the other hand, if the source and destination
VLANSs are of the same type, the port will be deleted from the source
VLAN.

Removing a Port from a Protocol-based VLAN

In the event that a port is not removed from a source VLAN subsequent
to a VLAN Move operation, it can be removed by performing the
following:

1 Select the segment(s) to be removed from the source VLAN window.
2 Select the ATMVLAN Move from the ATMVLAN menu.
3 When the VLAN Create window appears select the protocol type

“None.”

For each segment that was selected, a list of VLANSs that the segment
belongs to is displayed.

For each segment, select the VLANs from which the segment is to be
removed.

A list of all segments to be removed is displayed in the VLAN Move
window.

Press Apply on the VLAN Move window.
The segments are removed from the VLANSs.
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Local VLANs and
VLAN Move

Policy-Based Moves

Local VLANSs act as ““holding” VLANSs in the event that LAN Emulation
connectivity is incomplete. Although local VLANs cannot be directly
established by the ATMVLAN manager, they can be activated during a
VLAN Move operation involving ATM-based VLANS.

When Ethernet segments in a device are reassigned to a different VLAN
they are detached from the LEC of the old VLAN and attached to the LEC
of the new VLAN. When the new VLAN already exists in the device, then
the new segments are simply added to the others.

A different situation occurs when the new VLAN does not yet exist in the
device. A new LEC for the new VLAN needs to be established in the
device and that LEC needs to be connected to its LES. This process can
take time and in some cases may not succeed. Meanwhile, the Ethernet
segments to be moved are placed in a local VLAN created to hold them
temporarily. This is signified by a new VLAN icon with the label “Local
VLAN” appearing on the VLAN window. The segments to be moved are
inside the local VLAN icon and will appear on the destination VLAN
display only when the connection to the LES is complete.

Adding a segment or device to a policy results in the enforcement of the
policy on that device. The policies may be configuration policies, security
policies or other predefined policies. Devices or proxies that enforce the
policy continuously follow the following three procedures:

1 Snooping
2 Resolution
3 Configuration

Snooping

The device or proxy enforcing a policy will first snoop the frames going
throughout the device. Snooping allows the device to recognize various
frames or frame contents. This information is then used in the policy
resolution process.

For example: If a segment is assigned to a MAC-based auto-VLAN
configuration policy, the device containing that segment snoops on the
frames originating from behind that segment. After snooping it tries to
resolve the MAC address of the station residing behind that segment.
This information (the source MAC address) is then used to resolve the
VLAN configuration of that port.
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Using the information derived from the snooping procedure, the device
then attempts to resolve something based on the policy it is trying to
enforce. For example, if the policy is a MAC-based auto-VLAN
configuration policy, the device will resolve the MAC address to VLAN
mapping using external services where the mapping information is
stored. This may result in a query to an external server asking for the
VLAN mapping information. This resolution then results in a
configuration change, thus enforcing that policy.

Configuration

Following snooping and resolution, the device enforcing a policy will
make the necessary configuration changes in the device to enforce the

policy.

For example, if a device is enforcing a security policy on a segment, the
device first snoops for the MAC address of the station connected to that
segment. The device then resolves (concludes) if that MAC address is
allowed to use the network. The resolution may be based on a query to
an external MAC address inventory server. If the device resolves not to
allow the endstation to use the network, (if the MAC address is unknown
to the inventory server), the device can configure the port into a
partitioned state, thus enforcing a security policy on that port.

The following configuration policies are available in this release:
= MAC-based automatic VLAN configuration policy

Segments or devices assigned to this policy automatically are
configured into various VLANs based on a predefined MAC address to
VLAN mapping. This policy can be applied to the CoreBuilder
7x00-series interface cards and SuperStack Il Switch 2700, 1000,
3000 and Desktop Switches when used as ATM edge devices.

The MAC address to VLAN mapping information is stored in a
parameter database named MAC Vdb. This database can be
automatically populated with MAC address information by using the
BuildvDB tool. The BuildvDB tool, once activated, automatically builds
an inventory of MAC addresses that exist in the network.

= MAC-based VLSR

This policy is exactly same as the above MAC based policy but in this
case the MAC address to VLAN mapping is stored in an external VLAN
server parameter database. This policy is to be used when an external
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Performing
Policy-based VLAN
Moves

VLAN server is deployed in the network. This policy is not supported in
this release.

= |IP Subnet based automatic VLAN configuration policy

Segments or devices assigned to this policy will automatically be
configured into various VLANs based on a predefined IP Subnet
address to VLAN mapping. A parameter database called Subnet Vdb
must be created and setup using the Locator Tool prior to using this
policy. This policy can only be applied to CoreBuilder 7x00-series
interface cards and SuperStack Il Switch 2700 ports in this release.

= Null Policy

This policy is used for removing segments and devices from assigned
policies. Once segments or devices are placed in the Null Policy, the
original policy is no longer enforced on that device or segment.

ATM and VLAN Policies Map

The ATM and VLAN Policies Map, see Figure 5-5, is used for managing
the logical connectivity of end-users or segments through Virtual LANs
based on predefined policies. The ATM and VLAN Policies Map displays a
set of policies and the segments or devices assigned to each policy.

Each policy icon represents a predefined policy to which various segments
and devices in the network may be assigned. Once a segment or a device
is assigned to a policy via a simple move mechanism, the device



associated to the segment (or another proxy device) will enforce the
policy on that device or segment.
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Figure 5-5 ATM and VLAN Policy Map

You can move segments from one policy to another using the same
operations as the VLAN Move. See “Moving Ethernet Segments Between
VLANs” on page 5-1.

For a more detailed description, see “Configuring Policy-based VLAN
Auto-configuration” on page 4-24.

Enabling and
Disabling Ports

You can enable or disable ports from each device front panel display.

1 Double click on the port or select ATMVLAN Configuration Assistant. The
appropriate Configuration window appears.

2 Toggle on Enable or Disable.
3 Click Apply for changes to take effect.
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Manual LECS The Manual LANE Redundancy Configuration Assistant is used for

Database manually modifying a specific LECS database, to enable a backup LES, or

Modification to re-enable a primary LES when the backup is enabled. This
configuration assistant allows the operator to manage manual LANE
redundancy.

The failed LES is located according to its address by scrolling the ELAN IDs
window and the backup LES is activated by clicking on its radio button.

Manually Modifying LANE Redundancy

You can modify the database of an LECS that was not automatically
changed by the LANE monitor using the Manual LANE redundancy
Assistant.

To modify the database:
1 From the LAN Emulation window or Topology Browser select the

Backbone and Service icon or branch.

2 From the ATMVLAN menu select Zoom Physical. The Backbone and
Services window is displayed.

3 Select the LECS which contains the database you want to modify.

4 Select the Configure Assistant option from the ATMVLAN menu. The
Manual LANE Redundancy window is displayed. See Figure 5-6.
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Figure 5-6 The Backbone and Services Configuration Assistant/Manual LANE
Redundancy



Each ELAN contains two entries of LES addresses.

5 For each ELAN, select the LES that was not automatically changed.

6 Click Apply to update the database.

Vv

Manual LANE Redundancy operates on only one LECS at a time. You can
select the LECS in the Topology Tool or in the Backbone and Services map.

The Automatic LANE redundancy monitor, see page 4-14, must be
disabled and then restarted after manually fixing the LECS database.
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NETWORK TROUBLESHOOTING
TASKS

This chapter describes how to perform the following ATM and VLAN
Management network troubleshooting tasks.

The following topics are described:

« Color Status and Propagation

= Device Level Troubleshooting

= LANE Level Troubleshooting

= ATM Network Level Troubleshooting

» Virtual LANs Level Troubleshooting

« Path Assistants for Identifying Connectivity and Performance Problems

Color Status and
Propagation

An extensive context status notification scheme is supported in the ATM
and VLAN Management software.

The same network event may cause different status on different logical
maps/icons. For example, an LEC that cannot join its LES is considered a
critical event in the LAN Emulation Map and not necessarily a fault in the
ATM or Device map. The severity depends on the context or the logical
domain. Colors propagate upwards to the parent icon, so that the next
highest level window’s color is influenced.

There are high-end platform-configured icon status colors defined for
Transcend icons. Each status has a default color that can be changed by
the user.
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The icon statuses are listed in Table 6-1 according to the severity of the
fault.

Table 6-1 Color Coding Key

Status Color

Critical Red

Major Orange
Minor Yellow
Normal Green

User-definable Brown

Unknown Blue

Device Level Table 6-2 indicates operating statuses of the ATMVvLAN Device icons.

Troubleshooting _ _
Table 6-2 Color Key For Root Window and Devices

Status
Map Icon /Color Status Cause
Root Each icon reflects highest priority status of maps below it.

ATMVLAN Devices CoreBuilder, Switch Critical Does not respond to SNMP.
2700, 7X00, Switch
X000,CoreBuilder
5000, CoreBuilder
2500/6000, and

LANplex
2016/5000
Major There is a hardware problem
in the device.
Minor There are device ports which
are enabled but in down
state.

Normal Device operating normally.
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LANE Level Table 6-3 indicates operating statuses of the ATMvLAN Device icons

Troubleshooting
Table 6-3 Color Key for LANE Level

LAN Emulation All icons reflect highest priority status of maps below it.

Backbone and LES Critical Not defined for this version
Services
Major Does not respond to SNMP
Minor There is a user-defined name for
this VLAN ID, but there is no LEC
connected.
Brown There is no LEC connected.
Normal In operational state.
LEC Critical The LEC is not connected to the

LES. It may be in join, configure or
LECS connect state.

Major Does not respond to SNMP
Minor In initial state
Normal In operational state.

LECS Major Does not respond to SNMP
Minor Enabled but not active.

Unknown The LES is enabled but the LECS is
disabled on the CoreBuilder device.

Normal Enabled and operational.

LANE User LEC Critical The LEC is not connected to the
LES. It may be in join, configure or
LECS connect state.

Major Does not respond to SNMP.
Minor In initial state
Normal In operational state.
Segment Major The device connecting this segment

does not respond to SNMP.

Brown The first segment on the device
may appear in this status. All other
segments on the device are
operating normally.

Unknown Device (all segments) operating
normally.
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ATM Network Level Table 6-4 indicates operating statuses of the ATM and VLAN Network

Troubleshooting icons.

Table 6-4 Color Key for Network icons

ATM Network Switch Domain Critical

Major

Minor

Normal

One or more of the lower
level devices has an error of
highest severity

One or more of the lower
level devices has a hardware
problem.

One or more lower level

devices has device ports

which are enabled but in
down state.

Device operating normally.

ATM Switch This icon shows the highest priority status of the edge devices

Domain below it.

Virtual LANs Level Table 6-5 indicates operating statuses of the ATM and VLAN Network

Troubleshooting icons.

Table 6-5 Color Key for Virtual LANs Icons

Virtual LANs Virtual LAN Critical The LES is in major state.
Major One of the devices
configured to use this VLAN
does not respond to SNMP.
Minor There is a user-defined name
for this VLAN ID but there is
no LEC connected.
Brown There is no segment
connected.
VLAN LES Critical Not defined for this version.
Major Does not respond to SNMP.
Minor There is a user-defined name
for this VLAN ID but there is
no LEC connected.
Brown There is no LEC connected.
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Table 6-5 Color Key for Virtual LANs Icons

Normal Device operating normally.
Segment Major The device connecting this
segment does not respond
to SNMP.
Brown The first segment on the

device may appear in this
status. All other segments on
the device are operating
normally.

Unknown Device (all segments)
operating normally.

After the redundancy in the LAN Emulation Server has taken effect, the
LAN Emulation Clients (LECs) are moved to the backup services. There
may be circumstances where some of the LAN Emulation Clients (LECs)
remain connected to the primary LAN Emulation Server (LES) and are not
moved to the backup LES. This condition creates a VLAN (ELAN) split. The
VLAN split is caused because several LAN Emulation Clients (LECs)
belonging to the same ELAN are bound to different LAN Emulation
Servers. The split may occur when a LAN Emulation Server(LES) fails and
the NMS changes the LAN Emulation Configuration Server database.

Indications in the VLAN Map

You can see the indication of the VLAN split in the VLAN Map when the
icon for the primary VLAN (ELAN), with respect to the backup, is still
green. This condition indicates that LAN Emulation Clients are still
attached.

Under normal circumstances only one ELAN either primary or backup,
should be green.

Indications in the Backbone and Services Window

You can see the indication of a VLAN split in the Backbone and Services

window as different LAN Emulation Clients (LECs), belonging to the same
ELAN, are bound to both the primary and backup LAN Emulation Server

(LES) of an ELAN.
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To unify the split VLANS:

= Check that all the LAN Emulation Configuration Servers have the
same LAN that is displaying the split.

= Using the Network Management Station, move the ports displayed in
the primary VLAN to a temporary VLAN. Move the ports from the
temporary VLAN into the backup VLAN.

Empty ELANS in the network are indicated with a brown color key.

Path Assistants for
Identifying
Connectivity and
Performance
Problems

LE Path Assistant

ATM Path Assistant

You can use the ATM and VLAN Management Path assistants to display
the paths ATM devices and between network elements that are part of
LAN Emulation.

The LE Path Assistant allows you to select any two LE Clients or two LAN
segments and to obtain the following information:

= Address resolution through the LE Server

» Control distributed path (direct)

= Multicast forward addressing through the BUS

« Data direct path

The Path Assistant displays the corresponding segment, its proxy client, its

LE services ATM address, and assists in verifying that the connections are
viable.

To access the LE Path window, in the Topology Browser, click on two ATM
Switches and then click on the Path icon.

The ATM Path Assistant allows you to select any to ATM UNI or NNI
endpoints across the network and to see the physical path as well as the
VCCs established between the two endpoint. The following information
can be obtained from this assistant window:

= The physical path including all the intermediate switch nodes and the
physical link between them

= The ports at the ends of the physical links
» The VCCs established between the end points



Tracing a VC Path
Between Two ATM
End Nodes

Tracing the LAN
Emulation Control
VCCs Between Two
LANE Clients

Path Assistants for Identifying Connectivity and Performance Problems  6-7

The ATM path assistant also allows you to setup PVCs between the
selected endpoint.

To trace a VC Path between two ATM nodes perform the following tasks:

= Select two ATM end nodes in the Topology or management maps, and
then select the Path icon.

To trace the LAN Emulation control VCCs between two LANE clients
perform the following steps:

In the LAN Emulation Map or branch entry in the Topology Browser, select
two LECs attached to the same LES.

Select the Path icon.

The LE-Assist window is displayed showing the control VCCs between the
two LECs and the LANE services (LES/BUS).
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NETWORK PERFORMANCE
MEASUREMENT TASKS

This chapter describes how to perform the following ATM and VLAN
Management network performance measurement tasks.

The following topics are described:

» Measuring Network -wide ATM Traffic Performance Using the
Bandwidth Icon

= Measuring Device Level Performance

« Displaying Port Level Statistics

» LANE Component Statistics

= Switch Domain Statistics

Measuring Network
-wide ATM Traffic
Performance Using
the Bandwidth Icon

The Bandwidth icon opens the NNIx (Network Node Interface Traffic) Tool
that graphically displays the traffic patterns between ATM switches in the
network. It can be configured to collect, display and store information
about good or bad (error cell) traffic patterns across the network.

The NNIx Tool can be configured to collect traffic information between
two or more ATM switches. The ATM switches can be selected from a file
browser type selector window called NNIx Browser which lists all the ATM
switches in the network hierarchically based on Enhanced IISP address
structure. Selected ATM switches can be added to the NNIx Map using
the Hide (plus) Button. The Show Subtree (double plus) button can be
used to add the entire ATM switch hierarchy (a root switch and all the
switches below it). Upon adding switches to the NNIx map, the NNIx tool
automatically starts collecting traffic information on the NNI links
between the switches and the in and out traffic of each ATM switch.

The Configure option under the map menu of the NNIx map can be used
to customize the NNIx tool.
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NNIx Browser

The historical data collected and stored by the NNIx tool can be graphed
viewed as line graphs, pie charts and bar graphs.

The following sections describe the various components of the NNIx tool
as well as how to configure the tool for historical data collection.

The NNIx Tool is composed of two windows: the NNIx Browser and the
NNIx Map.

The NNIx Browser lists all the ATM switches in the network. The NNIx
Browser is used to select a switch, or multiple switches and add to the
NNIx map.
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Figure 7-1 The NNIx Browser

You can also select a hierarchy of switches to add or delete from the NNIx
map display. You may open several maps simultaneously for display, but
only one map may be active at a time. The active map is indicated with
three asterisks on the window title bar.

The convention used for active windows is not a highlighted title bar. The
NNIx Browser must be open to display NNIx maps. To exit the application,
close the NNIx Browser.

To display the switch hierarchy in the NNIx Browser

= Double click on an ATM Switch entry in Browser list.
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To select a switch for display on the active NNIx Map

1 Click on the ATM Switch entry in the NNIx Browser.
2 Click on the Show (plus) icon.

To select a switch hierarchy for display on the active NNIx map

1 Click on the ATM Switch entry in the NNIx Browser.
2 Click on the Show Subtree (double plus) icon.

Once the switches are added to the NNIx map, data collection starts
automatically.

To delete nodes from the NNIX Map:

SIn the NNIx Browser, select the node and then select the “-” icon

or

in the NNIx Map, select the nodes and then select Map -> Delete Node.

Select Map -> Clear All to clear all the nodes from the Map.

NNIx Map The NNIx Maps display the traffic patterns on the ATM switches. Each
NNIx map is given a unique consecutive number. After you close a map,
and open a new map, the map receives the first available number of the
map that was closed. For example, Maps 1, 2 and 3 are created. Map 2 is
closed. The new map will receive the number 2.
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Figure 7-2 NNIx Map



7-4 CHAPTER 7: NETWORK PERFORMANCE MEASUREMENT TASKS

Configuring and
Customizing the NNIx
Tool

Each ATM switch is displayed as a circular icon which is also a pie chart
representing the in and out UNI traffic corresponding to that switch. The
upper 1/2 portion of the pie represents the maximum percentage of
speed of the out traffic and is colored red.The lower portion of the circle
represents the maximum percentage of speed of the in traffic and is
colored magenta.

The IP address of the switch is labeled below a switch icon.

The lines between the switch icons represents the NNI links and the traffic
load on each link is dynamically updated and is represented by a unique
color. The links are color coded according to the following legend:

0-5% White
5-10% Yellow
10-20% Green
20-40% Blue
40-100% Red

The legend information can also be viewed by selecting the Map Legend
option under the Map menu of the NNIx map.

To display the node configuration:

Select the switch in the NNIx Map and then select Node Configuration.
The following static parameters of the switch are shown:

= name

= |P address

« ATM address

The NNIx tool has a very rich set of configuration and customization
options. To configure and customize the NNIx tool, select the
Configuration option in the Map menu of the NNIx Map.

The Configuration and Customization window contains the following
tabs.

« Map Configuration Tab



Measuring Network -wide ATM Traffic Performance Using the Bandwidth Icon  7-5

= NNIx Traffic Polling Configuration Tab
= Communication Configuration Tab
= History Configuration Tab

»« Simulation Configuration Tab
Map Configuration Tab

The Map Configuration tab allows you to configure the radius of the
switch icon as well as the layout of the map itself. See See Figure 7-3..
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Figure 7-3 The NNIx Configuration Map Tab

The Switch Radius sub-option allows you to modify the switch icon
radius. The recommended radius is 24, the default is 16.

The automatic map layout sub-option allow you to select one of the
following three layout options:

Disabled - Disables the automatic map layout
Rectangular - The map icons are laid out in a rectangle.
Circular - The map icons are laid out in a circle.

The Max%o Traffic option allows you to set the maximum percentage
traffic rate represented on a NNI link.
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NNIx Traffic Polling Configuration Tab

The NNIx Polling Configuration tab allows you configure the polling
interval for data collection of the NNIx Tool. See Figure 7-4.

- S
HE] Polling Lo ¢ aton Hetory | kmion |
Mag ¥ Enble
Charts ¥ Enmble
Ficrea seconds o .
Apphy and Exit | Appky | Carce

Figure 7-4 The NNIx Polling Configuration Tab
The following 3 sub-options are available:

= Map Enable - Check to enable or disable the dynamic updating of
traffic on the NNIx map.

=« Chart Enable - Check to enable or disable the dynamic updating of
node and link performance charts.

« Polling, Seconds: Allows you to select a polling interval for data
collection.
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Communication Configuration Tab

The Communication Configuration tab allows you configure the type of
data that is monitored and collected. See Figure 7-5.
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Figure 7-5 NNIx Communication Configuration Tab

» Good - configures the NNIx tool to collect data on Good Cells.

»« Bad - configures the NNIx tool to collect data on Bad Cells such as
Errored (BIP etc.), un-recognized ATM Cells.

You must restart the NNIx tool for the changes to take effect.
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History Configuration Tab

This History Configuration tab allows you to enable data archiving and
also set the storage interval. See Figure 7-6.
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Figure 7-6 The NNIx History Configuration Tab

When History is enabled, polled data is archived into log files in the
\TranscendNT\ATMVLAN\runtime\logs directory.

The historical link and node data can be graphed using the History menu
option in the NNIx Map.

While viewing a graph, a portion of the graph can be zoomed in on by
selecting it with the left mouse button. Press the ““R” key to Zoom out.

Simulation Configuration Tab

The Simulation Configuration Tab sets the NNIx tool into a data
simulation mode that displays random traffic patterns on the links and
nodes. See The number of Switch Nodes can also be also selected.You
must re-start the NNIx tool to set it into Simulation mode.

The simulation mode is useful for understanding and using the NNIx tool
when no live network traffic or network devices are available.
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Figure 7-7 The NNIx Simulation Configuration Tab

How to Graph Live  When the NNIx tool is running Link and Node level traffic can be graphed

Link and Node data using the Node performance and Link Performance menu options. This
information can be viewed as bar charts, pie charts or cumulative pie
charts.

To graph data from all links in the same graph:

= Select either the Bar, Pie or Cumulative Pie option from the Link
Performance menu in the NNIx Map.

To graph data from all nodes in the same graph:

= Select either the Bar, Pie or Cumulative Pie option from the Node
Performance menu in the NNIx Map.

To graph individual links or nodes:

« Select a link or node from the NNIx Map and then select either the Bar,
Pie or Cumulative Pie option from the Link or Node Performance
menu in the NNIx map.
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The bar graph shows the total in/out traffic percentages relative to the
switches maximum capacity for a node or link.
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Figure 7-8 The NNIx Bar Chart

The pie chart shows the percentage of in versus out traffic for a node or

link.
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Figure 7-9 The NNIx Pie Chart



The cumulative pie chart shows the combined throughput percentages of
in traffic and the combined throughput percentages of out traffic for
nodes and links.
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Figure 7-10 The NNIx Cumulative Pie Chart

Measuring Device
Level Performance

History Graph

The Performance Statistics windows display performance statistics for
different objects in the ATM Network. The Performance Statistics
windows are “live;” that is, there are updated automatically by
continuous polling of the system. An object can be device (for example a
Switch 2700 or CoreBuilder module), device port (Ethernet or ATM),
Emulated LAN entity (LEC or LES) or Virtual Channel. The windows use
history graphs, bar charts, pie charts and dials to display the performance
information. A sliding selector allows you to set the Polling interval. To
access these windows select the Graph Assistant option from the
ATMVLAN menu.

The history graph has the following features:

Slide bar: Enables display of previous samples.
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Displaying Statistics

Toggle legend: Clicking the middle mouse button while the cursor is
located inside the history graph will cause the legend to be hidden and
the graph to be widened. The widened display contains the same
information but is now easier to read. Another click on the middle mouse
button restores the original state.

Individual sample display: Clicking the right mouse button while the
cursor is located inside the history graph will enter the individual sample
display mode. This mode is indicated by the appearance of a cross-hair
cursor.

Position the cross-hairs at a desired point on the history graph and click
on the left mouse button. The detailed information about this sample
point will be displayed on the lower left corner of the graph. This
information includes sample number, sample time, sample graph and
sample value.

Clicking on the right mouse button while in the individual sample display
mode to return to the normal display mode.

To display statistics:

Select a network element in the management maps or, in the
Component View of the Topology Browser, select a network element
component.

Select Graph Assistant from the ATMvVLAN menu.

The CoreBuilder performance statistics window is displayed as in
Figure 7-11.



Figure 7-11 CoreBuilder Statistics
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Displaying Port To display port level statistics:
Level Statistics

1 Select a port from within the SuperStack Il Switch 2700 branch of the
Component View of the Topology Browser, or select a port on the front
panel display of the SuperStack Il Switch 2700 branch.

2 Select Graph Assistant from the ATMVLAN menu. See Figure 7-12.

Figure 7-12 SuperStack Il Switch 2700 Port Statistics Window

The window shows statistics of the message traffic through selected
Switch 2700 Ethernet port. The Switch 2700 Ethernet Port Statistics are
as follows:
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Traffic History graph through the port in frames per second. Four
separated sub-graphs are in the performance window:

Table 7-1 Traffic Graphs

Graph Meaning

inGood All valid frames received at the port
inError Errored frames received at the port
outGood All valid frames transmitted from the port
outError Errored frames transmitted from the port

Utilization Dial graph of utilization of maximum bandwidth (10Mbps)

of the port.

Total Frames Pie chart showing the distribution of all received and
transmitted frames broken down according to the following:

Table 7-2 Total Frames

Graph Meaning

inGood All valid frames received at the port
inError Errored frames received at the port
outGood All valid frames transmitted from the port
outError Errored frames transmitted from the port

Good Frames Pie chart showing the distribution of valid received and
transmitted frames according to the following:

Table 7-3 Good Frames

Graph Meaning

inUcast Unicast frames received at the port excluding discards

inNonUcast Broadcast and multicast frames received at the port
excluding discards

outUcast Unicast frames transmitted from the port including
discards

outNonUcast Broadcast and multicast frames transmitted from the

port including discards
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Errored Frames Pie chart showing the distribution of errored received
and transmitted frames according to the following:

Table 7-4 Errored Frames

Graph Meaning

inDiscards Frames received at the port but discarded for internal
reasons

inErrors Frames received at the port but discarded due to errors

inUnknown Frames received at the port but discarded due to

unknown protocols

outDiscards Frames discarded from being transmitted from the port
for internal reasons

OutErrors Frames discarded from being transmitted from the port
due to errors

LANE Component
Statistics

LES Performance

The LANE Component Statistics allow you to measure the performance of
LAN Emulation Services and LAN Emulation Clients in the network.

You can display statistics for the following LAN Emulation Services:

=« LES
« LEC
= LANE User

The LES performance statistics see Figure 7-13, allow you to see the type
of load that exists on the LAN Emulation Services and to use this
information for load balancing when required.

The LES Performance Statistics are as follows:

Data History graph of transmission rate of Broadcast and Unknown
data (BUS) in Emulated LAN.

Data Utilization Utilization of the transmission rate of the BUS service
relative to the maximum possible.

Control Frames Pie graph of quality of LE ARPs and other LAN
Emulation control frames handled by LES.

Errored Control Frames Pie graph of errored control frames.



Data/Control Octets pie graph of the ratio between LES transmission
rate and BUS transmission rate.
To display performance statistics for the LAN Emulation Services:

1 Select an LES icon from the management maps or an LES device
component in the Component View of the Topology Browser.

2 Select Graph Assistant from the ATMvLAN menu.

inOctets

Figure 7-13 LES Graph Assistant
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LEC

The LEC Graph Assistant, see Figure 7-14, shows statistics of the message
traffic through the LEC. The LEC Statistics are:

Data frames/sec History graph of the transmission rate of data frames
through the LEC.

Data Frames Pie graph of the distribution of different types of data
frames through the LEC.

Data Utilization Utilization of LEC data transmission rate relative to
the maximum possible rate.

Control frames/sec History graph of the transmission rate of control
frames through the LEC.

Control Frames Pie graph of the ratio of transmission of different
types of LEC control frames.

Data/Control Frames Pie graph of the ratio between LEC data frame
transmission and LEC control frame transmission.



To display performance statistics for an LAN Emulation Client:

1 Select an LEC icon from the management maps or an LEC device
component in the Component View of the Topology Browser.

2 Select the Graph Assistant option from the ATMVLAN menu.
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Figure 7-14 LEC Graph Assistant
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LANE User

The LANE User statistics parameters graph see Figure 7-15, displays a
group of statistics per LEC. The display shows the in traffic and out traffic
on the LEC and its segments. These graphs use the Transcend common
grapher tool. You may select to display all or part of the LEC groups in the
LANE User statistic.

To display performance statistics for an LEC:

Select the LANE User icon from the management maps or a LANE User
device component in the Component View of the Topology Browser.

Select the Graph Assistant from the ATMVLAN menu.
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Figure 7-15 Statistic of LANE User Group Window

To zoom into one or more of the graphs:
Double click on the graph. See Figure 7-16.
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Figure 7-16 LANE USER Statistics Graph Zoom Display
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Switch Domain To display the statistics from an ATM switch:
Statistics

1 Select the ATM switch icon.
2 Select Graph Assistant from the ATMvLAN menu.

Figure 7-17 displays the Graph Assistant for the CoreBuilder.

m -

Figure 7-17 Graph Assistant for the CoreBuilder switch



SUPPORTED DEVICES

This appendix describes the devices and system software supported for
the ATM and VLAN Management application.

Table A-O Supported Devices

Device

Description

CoreBuilder 7000/HD

CoreBuilder 7000 is an ATM switch, used in
an ATM network and serves as an LE
services entity as well.

CoreBuilder 7200, 7400, 7600

CoreBuilder 7200, 7400, 7600 are
CoreBuilder platform modules. They allow
legacy LAN to ATM connectivity. The 7200
and 7400 are Ethernet modules and the
7600 is a Fast Ethernet module. The
module’s port can be segmented into
different vLANs and be part of different
ELANs. The connectivity to the backbone is
ATM based.

Superstack Il Switch 2700

TheSuperStack Il Switch 2700 is an Edge
device.It allows Ethernet switching and
connectivity from Ethernet to ATM. It can
be segmented into multiple bridges to allow
virtual LANs. The virtual LAN is ATM LE
based.

SuperStack Il Switch 2000TR

SuperStack Il Swtich 2000 is a token ring to
ATM edge device and supports token ring
LAN Emulation. It can be used for
connecting token ring end stations to an
ATM switch backbone.

SuperStack Il Switch 1000

SuperStack Il Switch 1000 is an edge device.
It allows Ethernet switching and connectivity
form Ethernet to Fast Ethernet and Ethernet
to ATM. It can be segmented into multiple
bridges to allow virtual LANs. The virtual
LAN is both encapsulated based when
connected to Fast Ethernet Backbone or
LAN Emulation when connected to ATM
Backbone.
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Table A-O Supported Devices

Device

Description

SuperStack Il Switch 3000

SuperStack Il Switch 3000 is a Fast Ethernet
switch. It allows Fast Ethernet switching and
connectivity form Fast Ethernet to ATM. It
can be used as a Backbone switch to
connect multiple LS1000 devices, thus
creating a FE/Ethernet network. It can be
segmented into multiple bridges to allow
virtual LAN. The Virtual LAN is both
encapsulated based when connected as Fast
Ethernet Backbone or LAN Emulation when
connected to ATM Backbone.

CoreBuilder 2500

CoreBuilder 2500 is a high end switch. It
allows Ethernet, FDDI, Fast Ethernet
switching and connectivity form legacy LANs
to ATM. It also allows routing to fulfill the
function of routing between vLAN as well as
IP, IPX and other protocol routing. The FDDI
connectivity allows it to be the FDDI
backbone edge switch. It can be segmented
into multiple bridges to allow virtual LANs.
The virtual LAN is LAN Emulation based
when connected to the ATM Backbone.

CoreBuilder 5000 Switch Modules

The CoreBuilder 5000 device is a
Multifunction hub. It is an Ethernet, FDDI
HUB and has the switching capability of
ATM, and Ethernet. It also allows
connectivity form legacy LAN to ATM. It can
be segmented into multiple bridges to allow
virtual LANs. The Virtual LAN is LAN
Emulation based when connected to ATM
Backbone.

CoreBuilder 4000/CoreBuilder

CoreBuilder 4000 is an ATM switch, used in

5000 Switch an ATM network and serves as an LE
services entity as well.
Netbuilder I NetBuilder Il is a high perfromance

multi-protocol router for LAN and WAN
environments. In the ATM and VLAN
environments it can be used as an inter
VLAN one-armed router connected to the
ATM backbone.




TROUBLESHOOTING

System Problems

Icons Present at
Startup

Window Not
Generated

The following system problems can arise during a session:

Problem:

The Enterprise VLAN icons are already present in the Root window
when the application is started. The reason is that HPOV was previously
terminated abnormally. Note: this problem is not applicable when using
the Save Map option.

Action:

Select the Enterprise VLAN icons in the Root window and then select
Edit-> Delete-> From All Submaps to remove the icons.

Problem:

A Configuration, or Graph window does not open after being
requested. The initialization message window remains indefinitely on
the screen.

Action:

Restart the Enterprise VLAN Management application.
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Problem Starting the
Application

Set Operation Failed

Slow System Startup

Problem:

If you are having problems starting the application or discovering
devices, you can enable the error log feature of the Enterprise VLAN
application.

Action:

Generate an application error log. To activate the log you need to
create a file in : "\TranscendNT\ATMVLAN\runtime\cnf\"* directory named
“atmvlan.dbg"'.

Enter the following two lines:

all

end;
in the file.
The log files will be created in the
"\TranscendNT\ATMVLAN\runtime\log\"* with the name StdError.txt and
StdOut.txt .

Note:Do not leave this option o. The StdError.txt and StdOut.txt do not
have a maximum size limit.

Problem:
SNMP set operation failed.
Action:

Be certain that you are using the correct SNMP set community. Check
network connectivity.

Problem:

The Enterprise VLAN icons do not appear in the Root window after
starting up the application. It may take between 5 to 20 minutes for
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the icons to appear and the application to startup. This situation occurs
when the station has a defined DNS and cannot reach it.

Action:

Remove the DNS definition or check how the station can reach the
DNS. This is a system problem due to the DNS definition.

Slow System Startup Problem:

The Enterprise device icons are displayed at a slow rate (one by one) in
the Enterprise Devices window.

Action:

Clear the HP OpenView database. This problem occurs when the HP
databases are overloaded. Refer to the HPOV documentation.

System Messages The following are the system messages that may appear on the screen
together with their meaning and suggested action for you to take. The
messages are displayed in a special dialog box. Three types of messages
are displayed: informational, warning, and error.

The following Motif symbols are used:

i - info
I - warning
0 - error
Message Level Meaning Action
Table B-1 System Messages
Message Type Meaning Action
General: Help utility is not available in info None
this version.
General: Busy, Cannot open new error User attempted to open an Wait until previous operation
window. Wait until previous operation application while the previous is completed.
is completed. application is still opening.
General: Cannot close window while  warning Wait until window is open
it’s initializing. Wait until window is and then close it.

open and then close it.
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Message Type Meaning Action
ATMVLAN Devices Configuration: error Change IP address.
Invalid IP address
ATMVLAN Devices Configuration: error Change Community string.
Invalid Community string
VirtualLANs Configuration: No VLAN  error Application needs LAN Enable at least one LES and
IDs found. Operation aborted. Emulation Services (LES) and  then try again
they are not defined on the
Network
VirtualLANs Configuration: Cannot error Change file writing
open file VnRgb for writing: permissions.
permission denied. Operation aborted.
VirtualLANs Configuration: No blanks  warning Re-enter VLAN name.
allowed in VLAN name. The VLAN will
be [truncated name].
VirtualLANs Configuration: VLAN must warning
have its VLAN ID as one its names.
Name not deleted.
VLAN Move: Trying to move LEC warning Select a different VLAN.
segment - [segment number] - to
WorkGroup - [WorkGroup]. Segment
skipped
VLAN Move: Trying to move warning Select a different VLAN.
WorkGroup segment - [segment
number]- to - ELAN/[VLAN]. Segment
skipped.
VLAN Move: Select segments from error You cannot create a local
one device only. Operation aborted. VLAN on more than one
device in one action. Use a
separate Move command for
each device.
VLAN Move: Operation completed info None
successfully for device - [device IP
address]
VLAN Move: No P2C found in device - error Check the P2C card.
[device IP address]. Device skipped.
VLAN Move: SNMP GET error - [SNMP  error Wait for the ATMVLAN maps

status]- in device -[device IP address].
Device skipped.

to refresh. Check the VLAN
maps for results of the
previous operation and then
retry.
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Message Type Meaning Action
VLAN Move: SNMP SET error - [SNMP  error Wait for the ATMVLAN maps
status]- in device -[device IP address]. to refresh. Check the VLAN
Device skipped. maps for results of the
previous operation and then
retry.
VLAN Move: No available LECs left in  error Remove one or more VLANS
device - [device IP address]. Device from the device. To remove,
skipped. use the VLAN Move operation
and move all the device
segments from the VLAN.
VLAN Move: Cannot find LEC in error Reset CoreBuilder 2500/6000
device [device IP address]. Device or LANplex 2016/5000 and
skipped. retry the operation. If you do
not succeed, you may have a
problem with your device.
VLAN Move: Cannot create LEC - No  error Check the ATM card.
ATM card in device [device IP address].
Device skipped.
VLAN Move: Cannot move to VLAN - error This move operation is You may perform one of the
[VLANID] in device - [device IP intended to the create a new following actions:
address]. Might create two VLANS that VLAN. Because of a mismatch ) « ‘s
use the same ELAN. Device skipped. between the current and L Deflge the ,?dmm a_md
. A - the “default” VLANSs in the
config VLANSs in the device, VirtualLANs Configuration
creating the desired VLAN window 9
might result in two VLANs ’
that use the same ELAN. 2 Reset device to synchronize
the current and config
VLANS.

3 Using the LMA, remove
non-existing VLANs from
the device.

4 Verify that the desired
VLAN is using its primary
ELAN.

Polling: SNMP GET Error - [SNMP error Restart polling.

status] - in device - [device IP

Address]. Polling aborted.

Polling: SNMP GET timeout in device info None

[device IP address]. Retrying.

VC Path Assistant: VC list is full in error No space to define new PVC. Delete some VCs and try

device - [device IP address]. Operation

aborted.

again



B-6 APPENDIX B: TROUBLESHOOTING

------

Table B-1 System Messages

Message

Type

Meaning

Action

VC Path Assistant: SNMP SET error -
[SNMP status] - in device -[device IP
address]. Operation aborted.

error

Retry operation

VC Path Assistant: SNMP GET error -
[SNMP status] - in device -[device IP
address]. Operation aborted.

error

Retry operation

VC Path Assistant: Invalid VPI/VCI pair
- [vpi-vci]. Operation aborted.

error

Re-enter vpi vci

VC Path Assistant: Invalid VPI - [vpi].
Operation aborted.

error

Re-enter vpi

VC Path Assistant: Invalid VCI - [vci].
Operation aborted.

error

Re-enter vci

VC Path Assistant: Invalid entry -
[entry value]. Operation aborted.

error

Re-enter entry

VC Path Assistant: AALS parameters
setting window is not available in this
version.

info

None

VC Path Assistant: Traffic parameters
setting window is not available in this
version.

info

None

LECS Configuration: SNMP SET error -
[SNMP status] - for LECS - [lecs].
Operation aborted.

error

None

Backbone Services Configuration:
ELAN ID changed for LES [LES ATM
address]. Remove this address from
LECS before you can use the new ID.

warning

Remove the address and
re-open the window.

Backbone Services Configuration:
Cannot find ELAN ID for backup
address of ELAN ID - [ELAN ID].
Changing backup to default.

warning

None

Backbone Services Configuration:
Cannot delete (ELAN) because admin
uses it. No ELANs deleted.

warning

None

Backbone Services Configuration:
Cannot delete (ELAN) because default
uses it. No ELANs deleted.

warning

None

Backbone Services Configuration:
Cannot delete (ELAN) because it’s the
backup of admin/backup [VLAN]. No
ELANs deleted.

warning

None
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Message

Type Meaning

Action

Backbone Services Configuration:
SNMP SET error - [SNMP status] - for
CoreBuilder - [device IP address].
CoreBuilder skipped.

error

None

Backbone Services Configuration:
LECS DB is not synchronized. Make
sure to synchronize it using this
window.

warning

Synchronize the DB.

Backbone Services Configuration:
SNMP GET error - [SNMP status] - for
LECS - [device IP address]. Operation
aborted.

error

None

VLAN Creation: Must enter VLAN ID.
Operation stopped.

warning

Re-enter VLAN ID.

VLAN Creation: No blanks allowed in
VLAN ID. Operation stopped.

warning

Re-enter VLAN ID.

VLAN Creation: [network number]
must be a valid IP Address. Operation
aborted.

error

Re-enter network number.

VLAN Creation: [network mask] must
be a valid IP Address. Operation
aborted.

error

Re-enter network mask.

VLAN Server: VLAN Server is not
defined. Use ""VLAN Server Setup” to
define it.

warning

Define the VLAN Server IP
address and try again.

VLAN Server: SNMP GET error - [SNMP
status] - in Server - [device IP address].
Operation aborted.

error

None

LECS Configuration: LECS is not
enabled. Operation aborted.

error

None

LECS Operation: SNMP GET error -
[SNMP status] - for LECS - [device IP
address] Operation aborted.

error

None

LECS Operation: Cannot find LES ATM
address for alias - [alias]. Operation
aborted.

error

Reset the LECS CoreBuilder to
the factory default and restart
the operation.

LECS Operation: Cannot find ELAN ID
for alias - [alias]. Changing [alias] to
[first ELAN in the list].

warning

None

MEDRP is not running

error

Start the MEDP Poller. Select
Start-> Programs-> Transcend
ATMVLAN -> ATMVLAN Poller.
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Table B-1 System Messages

Message Type Meaning Action

PDP is not running error Start the PDP Poller. Start->
Programs-> Transcend
ATMVLAN -> ATMVLAN PDP

Locator - All fields are empty error Locator cannot process Fill in at least one field of

request since all fields were data.
empty.

Locator - Field <Field Name> is error Incorrect entry in Field Name  Correct the entry.

incorrect

Locator -Error during writing to file error

""<File Name>""

Locator - Values are incorrect error From VLAN Server setup, Check the VLAN Server entries
in the VLAN Server tab

Locator - New row will be added to warning

Database .Are you sure? Yes,Cancel

Locator - Row will be deleted from warning

Database. Are you sure?,Yes,Cancel

Locator - Row will be replaced in warning

Database. Are you sure? Yes,Cancel

Locator - Database will be saved. Are  warning

you sure? Yes,Cancel

Locator - Changes in Database were  warning

not saved. Save and Exit, Exit without

Saving,Cancel

Locator - Changes in Database were  warning

not saved. Save,Don't Save,Cancel




ATM AND VLAN MANAGEMENT
BASICS

An Introduction to
ATM and VLAN
Management Basics

In 1986, the International Telecommunications Union (ITU) formed a
study group to explore the concept of a high-speed, integrated network
that could uniformly handle voice, data, and a variety of other services.
This resulted in BISDN, or the Broadband Integrated Services Digital
Network. BISDN services require high-speed channels for transmitting
digitized voice, data, video, and multimedia traffic. Asynchronous
Transfer Mode (ATM) is the switching and multiplexing technology for
supporting BISDN services.

One of the greatest challenges in defining ATM was to determine a
structure that could efficiently handle any type of traffic. Such a structure
must accommodate a variety of bit rates and support bursty
communications, since voice, data, and video traffic all exhibit bursty
behavior.

Packet-switching has been the technology of choice for bursty data traffic
because it consumes bandwidth only when traffic is present. Traditional
packet-switching mechanisms cannot achieve the performance and
speed required for real-time, two-way traffic. ATM overcomes this
limitation by offering fixed-length packets. Each ATM packet, called a cell,
consists of a 48-byte payload and a 5-byte header. Fixed-length ATM cells
offer several advantages:

»« Networking and switching queuing delays are more predictable with
fixed-length data cells.

» Itisless complex and more reliable to process ATM cells than
variable-length packets.

» Fixed-length cells allow cell-relay switches to process cells in parallel,
for speeds that far exceed the limitations of bus-based switched
architectures
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ATM Basics

ATM uses short, fixed-length packets called cells. The first five bytes of
each cell, the header, contain the information necessary to deliver the cell
to its destination.

The fixed-length cells offer smaller and more predictable switching delays
as cell switching is less complex than variable-length packets and can be
accomplished in hardware for many cells in parallel. Having all data in the
same cell format speeds transmission dramatically by obviating the need
for protocol recognition and decoding. A good analogy is containerized
shipping, where uniform shape and weight of containers and
standardized labeling considerably ease and quicken processing.

The cell format also allows for multiprotocol transmissions. Since ATM is
protocol-transparent, the various protocols can be transferred at the
same time. With ATM, one line can carry phone, fax, video, data and
other information simultaneously. This multiprotocol advantage also
offers scalability, greatly reducing the configuration changes necessary for
adding a new traffic type to your network.

The Role of Edge Devices

All ATM traffic-handling decisions are based on the information in the
destination header, not on the content of the cell payloads. To move
traffic through the ATM network, devices at the boundary or edge of the
network convert non-ATM traffic streams into cells. The addition of new
traffic types requires only a new edge device, deployed where the
demand for such traffic exists.

ATM is a connection-oriented transport service. With only five bytes of
header, an ATM cell cannot carry the full destination address for each cell.
Instead it uses an abbreviated address, called a virtual channel identifier,
that provides enough information to establish a connection between two
ATM stations. Once a connection exists through the ATM network,
communications can ensue.

Legacy LANs employ connectionless transmission technology based on
48-bit addressing. This edge devices must have some way of adapting
existing network protocols, such as IP and IPX, to the connection-oriented
cell-switching paradigm.

ATM provides the User Network Interface (UNI) which is typically used to
interconnect an ATM user with an ATM switch that is managed as part of
the same network, as well as the Network-to-Network Interface (NNI)
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which is typically used to interconnect two ATM switches managed as
part of the same network.

= The UNIis the physical interface between the user and the network.
A private UNI consists of a private end-point to private switch
interface, whereas a public UNI is typically used to interconnect an
ATM user with an ATM switch deployed in a public service provider’s
network.

= The Network-to-Network Interface (NNI) defines the ATM switch
(network) to ATM switch (network) interface. It is also known as a
private NNI (P-NNI) when the switches are not part of a WAN. NNI
allows multiple switches to be interconnected in arbitrary topology
and still work as one network.

ATM is based on a layered architecture. In the protocol stack, the ATM
layer sits directly above the physical layer. Many physical layers can be
specified, including several for 100 to 155 Mbps. The ATM adaptation
layer (AAL) sits above the ATM layer. LAN Emulation (LE) sits above the
AALS5 in the protocol hierarchy.

ATM switching is performed at the ATM layer by defining virtual
channels. Cells are switched through the network based on the cell
header, therefore the routing is done for every cell and hence the virtual
channel.

Virtual Channels

Virtual channels are communications channels that provide for the
sequential, unidirectional transport of ATM cells. Multiple virtual channels
can exist on a physical link. There are two types of virtual channels:
Virtual Path Connection (VPC) and Virtual Channel Connection (VCC). A
VPC is a collection of VCCs (see Figure C-1).

A VCC extends between two end-points in the network and is uniquely
identified by the Virtual Path Identifier (VPI) and Virtual Channel Identifier
(VCI) values. It is also called a point-to-point VCC. A VPC extends
between two end-points in the network and may contain multiple VCCs.
VPCs are uniquely identified by the VPI value. VPCs and VCCs can be set
up either dynamically via signalling or permanently via management.

The VPI/VCI is only meaningful in the context of the given interface. The
combination of the VPI/VCI values allows the network to associate a given
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cell with a given connection, and therefore it can be routed to the right
destination. Identical VPI/VCI combinations may exist on different
interfaces.

The VPl is a bundle of VCs. Individual VCs have unique VCI values, but the
VCl values may be reused in each VP.

VC Switch

1
VCIJMCIZ /BCB $0I4
[~ ~

ven VPI1
VCi2
VClI1

Endpoint
of VPC

VPI3 >: VvCI2
vCl \Ve]]
o [ VPI5 VP14 cis
VCl4 N
VP Switch
Physical Link .
VCI = Virtual Channel identifier Virtual Path
—— i Virtual
VP == Virtual Path Channels

VPI = Virtual Path identifier

Figure C-1 Virtual Path/Channels Connections
Two levels of virtual channels are supported at the UNI:

= A Virtual Channel Connection (VCC) that consists of a single
connection established between two ATM end-points.

= A \Virtual Path Connection (VPC) that consists of a bundle of VCCs
carried transparently between two ATM end-points.

Connections can be established via management (Permanent Virtual
Channels) or dynamically (Switched Virtual Channels).

Permanent Virtual Channels (PVCs) This most basic connection
setup requires the definition of each connection by management (for



example, SNMP). Permanent connections generally remain established for
long periods of time. These connections are not dynamically checked and
reinitiated.

The major features of a PVC include:

= Connections initiated by network administrator.

= Connections established and released manually.

= Long-term duration connections.

« Both point-to-point and point-to-multipoint connections can be
established.

Switched Virtual Channels (SVC) An SVC dynamically defines
connections as they are needed and releases them when complete, using
signaling complying with ATM Forum UNI standards. By using an SVC,
ATM devices (for example, a LAN Emulation UNI and an ATM switch) can
exchange connection characteristics (for example, QOS, VPI/VCI) when
establishing connections. These connections remain active for an arbitrary
amount of time and depend upon application demand. Both
point-to-point and point-to-multipoint connections can be established.
An SVC eliminates the need for an external management station for
setting up virtual channels.

The major features of an SVC include:

« Connections initiated by the user/application.

= Connections established and released dynamically.
= Connections established via the signalling protocol.
= Varied connection duration.

Table C-2 compares SVC and PVC connections.

Table C-2 Comparison of SVC and PVC

SVvC PVC

Demand connections Permanent connections

Not automatically re-established Automatically re-established after
after network failure network failure

Remain active for arbitrary amount Remain active for long periods of
of time time
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Virtual LAN Basics

Table C-2 Comparison of SVC and PVC

SvC PVC

Supported by signaling standard Supported by MIB or other
management entity

Integrated ATM/Ethernet Switching

ATM Backbone Network When Ethernet LANs are connected through
a conventional switching hub or backbone, the bandwidth provided is
restricted to the data rate of the Ethernet or FDDI technology running on
it. If, instead, the Ethernet LANSs are connected through an ATM
backbone switch - creating an integrated ATM/Ethernet network - the
bandwidth bottleneck is opened up and performance is increased across
the combined network. The Ethernet switches pass only those messages
whose sender and receiver are in separate Ethernet LANs to the ATM
Switch, thereby reducing the message traffic on the combined system.
Furthermore, the high-speed switching rate and efficient time-utilization
of ATM are responsible for the high throughput of the ATM/Ethernet
network system.

The ATM/Ethernet network system also opens new possibilities in
network design. Instead of being restricted to LANs, whose users are
connected by a physical cable, new efficient LANs can be created which
cross physical LAN boundaries. The sophisticated address handling of
ATM allows related users in separate physical LANs to be effectively
grouped into a common broadcast domain called a Virtual LAN. Virtual
LANs are described in the next section.

Just as an Ethernet LAN enables a group of stations to communicate
efficiently on a common physical bus, so new networking technology
such as ATM makes it possible for stations on different LANs to
communicate with almost the same efficiency, even when separated by
great distances. This allows network managers to group remote stations
that need to communicate frequently into a common high-bandwidth
broadcast domain called a Virtual LAN. For example, marketing
department personnel who happen to work in different physical locations
could be formed into one Virtual LAN and engineering department
personnel into another. The term ““Virtual LAN” is used because
communicating stations continue to transmit and receive as though they
were on the same physical Ethernet LAN. In this manual, the abbreviated
expression “VLAN” is used for a Virtual LAN.



Advantages

VLAN Types

In practice, it is not the individual LAN stations that are formed into
VLANS but rather the physical Ethernet LANSs, called Ethernet segments,
that are grouped into VLANSs. Thus, all stations on an Ethernet segment
will be on the same VLAN. Also, since an Ethernet segment is connected
to the network through an Ethernet port in an edge device, the Ethernet
port itself is sometimes referred to as a member of the VLAN.

A Virtual LAN, as opposed to an Ethernet LAN, has the great advantage
of being very easy to manage from a central location. Stations are added
or removed from Virtual LANs by software without regard to their
location, there is no need to change physical connections.

The organization of the network into VLANSs also reduces congestion
from broadcast frame transmissions. Broadcast frames are now sent only
to members of the same VLAN instead of to all stations on the network.

Virtual LANs also offer network security for their members. Because
transmissions do not normally cross from one VLAN to another, a VLAN
will remain immune to transmission problems or congestion that may
occur in another VLAN in the network.

According to the enabling technology, VLANSs are divided into three types:
ATM-based VLANSs, tag-based VLANs and protocol-based VLANSs. In the
following sections each of these VLAN types is discussed. These Virtual
LAN types are implemented in 3Com products as follows:

Table B-1 VLAN Types in 3Com products

VLAN Type 3Com Product

ATM-based CoreBuilder 7000
CoreBuilder 7X00
SuperStack Il Switch 2700
CoreBuilder 5000

SwitchModule
Tag-based SuperStack Il Switch

1000/3000
Protocol-based CoreBuilder 2500/6000

These three VLAN types are discussed in the following sections.
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LAN Emulation
Client (LEC)

ATM-based VLANSs

When the enabling technology is ATM, the VLAN is referred to as an
ATM-based VLAN. An ATM-based VLAN is built around an ATM network
structure called an Emulated LAN.

LAN Emulation The main objective of the LAN Emulation (LE) is to
enable existing applications to access an ATM network via protocol stacks
as if they were operating over traditional LANs. LE enables data
networking protocol software to benefit from high-speed ATM
networking without modification. Legacy end stations can use LE to
connect to other legacy systems, as well as to ATM-attached servers,
routers, switches and other networking devices. LE is completely
independent of upper-layer protocols, services, and applications.

Because LE is implemented in edge devices and end systems, it is
completely transparent to the ATM network and to legacy LAN devices.
LE masks the connection setup and handshaking functions required by
the ATM switch. In addition, it maps the MAC address-based networking
protocols into ATM virtual channels. The ATM network appears to
function like a connectionless LAN.

LAN Emulation Components An Emulated LAN (ELAN) is composed
of a set of LAN Emulation Clients (LECs) and a single LAN Emulation
Service, consisting of LAN Emulation Server (LES), and Broadcast and
Unknown Server (BUS). In addition there is also a LAN Emulation
Configuration Server (LECS) that services all the Emulated LANSs that exist
in the ATM network. Refer to Figure C-3.

One or more Emulated LANs can run on the same ATM network. Each
Emulated LAN is independent of the others and there is no direct
communication across Emulated LAN boundaries.

An ATM-based VLAN is simply an ELAN together with all Ethernet LANs
attached to the LECs of the ELAN.

The LAN Emulation Client is the entity in end systems (e.g., a Super Stack
[l Switch 2700 module) which represents the member Ethernet LANs and
performs data forwarding, address resolution, and other control
functions. If the LEC is attached to an Ethernet bridge, rather than
directly to a Ethernet LAN, the LEC acts as a proxy to MAC addresses of
Ethernet LANs attached to the bridge. Also provided is a MAC-level



LAN Emulation
Configuration Server
(LECS)

LAN Emulation
Server (LES)

Broadcast and
Unknown Server
(BUS)

Virtual Channel
Connections (VCC)

emulated Ethernet service interface to higher level software which
implements the LAN Emulation User-to-Network Interface (LUNI).

The LAN Emulation Configuration Server implements the assignment of
individual LAN Emulation Clients to different emulated LANs. When a LEC
initializes, it establishes connection to the LECS. Based on its own policies,
configuration database and information provided by clients, the LECS
assigns any client which requests configuration information to a
particular emulated LAN service by giving the client the LES’s ATM
address. This method supports the ability to assign a client to an
emulated LAN based on either the physical location (ATM address) or the
identity of a LAN destination which it is representing (ELAN name).

The LAN Emulation Server implements the control coordination function
for the emulated LAN. The LAN Emulation Server provides a facility for
registering and resolving MAC addresses to ATM addresses. Clients may
register the LAN destinations they represent with the LAN Emulation
Server. A client will also query the LAN Emulation Server when the client
wishes to resolve a MAC address and/or route descriptors to an ATM
address in a process called LE Address Resolution Protocol (LE_ARP). The
LAN Emulation Server will either respond directly to the client or forward
the query to other clients and then forward the client response. In an SVC
environment, the LES responds directly to the LE_ARP to enable an LEC to
locate the BUS.

The Broadcast and Unknown Server handles the following:

« Data sent by a LAN Emulation Client to the broadcast MAC address.
» All multicast traffic.

» Initial frames which are sent by a LAN Emulation Client before the
data direct virtual channel to the ATM address has been resolved.

All broadcast, multicast and unknown traffic to and from a LAN
Emulation Client passes through a single BUS.

The BUS also handles ATM connections and manages its distribution
group.

Figure B-1 Communication among LAN Emulation Clients and between LAN
Emulation Clients and the LAN Emulation Service is performed over ATM Virtual
Channel Connections (VCCs). Each LAN Emulation Client must communicate
with the LAN Emulation Service over control and data VCCs. Emulated LANs
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operate in a Switched Virtual Channel (SVC),Permanent Virtual Channel (PVC), or
mixed SVC/PVC environment.

NG __yp LECS e _

LECS - LAN Emulation Configuration Server
LES - LAN Emulation Server

LEC - LAN Emulation Client

BUS - Broadcast and Unknown Server

Figure C-3 LAN Emulation Components
Admin and Default VLANs

Two special purpose ATM-based VLANSs are established automatically by
the system, the Network Administration VLAN and the Default VLAN.

The Network Administration VLAN To control the ATM Network and
receive status information from it, the Transcend ATM and VLAN
Manager requires SNMP connectivity to each device in the network at all
times. In the SuperStack Il Switch 2700 module, a special VLAN (“admin”
VLAN) is dedicated to efficiently implement this connectivity in a way that
is not affected by changes in the network. The initialization procedure
described in this chapter establishes such an Admin VLAN.

It is possible for the Transcend ATM and VLAN Manager to operate
b without a dedicated Network Administration VLAN. To manage the

devices, the device must have an IP address configured to one of the

bridge groups and the device must be reachable directly via a router. If
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the configuration is such, the network manager should ensure that IP
connectivity to the device is not affected by VLAN moves.

The Default VLAN When an ATM edge device is initialized, a single
VLAN called the default VLAN is created automatically and all ports of
the device are assigned to it.

In the SuperStack Il Switch 2700 module, the Admin VLAN is also used as
the Default VLAN when the SuperStack Il Switch 2700 is first initialized.
All ports are initially assigned to the Admin VLAN to ensure that they
have connectivity to the network. The Network Administrator can then
move the ports to another VLAN. At least one port must remain in the
Admin VLAN if the device is to be reached for management purposes.

Non-ATM VLANSs

VLANS can be created on non-ATM based switches by using either
packet-tagging or packet-filtering (policy-based) techniques. The
Superstack Il Switch 1000/3000 uses the packet-tagging mechanism.
VLAN management in the Superstack Il Switch 1000/3000 system is
supported by a “VLAN Server” - a database which stores and retrieves
information about station VLAN membership.

The CoreBuilder 2500/6000 uses packet-filtering. The CoreBuilder
2500/6000 can link up with Emulated LANSs to create policy-based Virtual
LANs ““over ATM.”” The following sections describe both these VLAN
mechanisms.

Tag-based VLANSs

In tag-based VLANS, as employed by the Superstack Il Switch 1000/3000,
ports can be grouped across multiple switches to form a single broadcast
domain. Packets within each VLAN group are tagged with a unique
identifier. The switches segment the traffic using these identifiers. Each
Superstack Il Switch 1000 can support up to 16 VLANs and you can have
more than 16 VLANSs in your entire network by connecting the 16 Switch
VLANS to other VLANS using a router.

VLANS can be defined in a single switch unit or can span several Switch
units. When a VLAN spans two switch units, they are connected using
backbone ports. The tagging method, described below, makes it possible
for a single backbone port to carry the traffic for all VLANs defined in a
switch. In that case, the backbone port is referred to as a Virtual LAN
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Trunk (VLT). A VLT port in one switch unit must be connected only to a
VLT port in the second switch unit so that the traffic can be switched to
the correct VLAN.

Tagging To distinguish between data frames belonging to different
VLANS which are sent over a common VLT between two switch units,
frame tagging is employed. Each frame which is sent along the VLT is
tagged with a VLAN identifier.

The tag is added to the frame (encapsulated) by the transmitting switch
port and is removed by the receiving switch port, restoring the original
frame. Alteration of the original frame only occurs in transmissions
between switch devices and is not propagated to the rest of the network.

Protocol-based VLANSs

Protocol-based
VvLANS

One port in multiple
VLANS

Protocol Suite

In the LANplex 2500/6000, VLAN membership is based on a set of
policies, or criteria, for grouping users.

Protocol-based VLANs group one or more switch ports together for a
specified network layer 3 protocol, such as IP or AppleTalk. These VLANs
make flooding decisions based on the network layer protocol of the
frame. In addition, for IP VLANS, you can also make flooding decisions
based on layer 3 subnet address information.

Protocol-sensitive VLANSs allow the restriction of flood traffic for both
routable and non-routable protocols. They have a relatively simple
configuration comprising one or more protocols and groups of switch
ports. These protocol-sensitive VLANs operate independently of each
other and are simple to configure.

Additionally, the same switch port can belong to multiple VLANSs. For
example, you could have port 1 on a LANplex assigned to several IP
subnet VLANS, plus one IPX VLAN, one AppleTalk VLAN, and one NetBIOS
VLAN. In a multiprotocol environment, protocol-sensitive VLANs can be
very effective for controlling broadcast and multicast flooding.

The protocol suite describes which protocol entities can comprise a
protocol-based VLAN. For example, LANplex VLANSs support the IP
protocol suite, which is made up of the IP, ARP, and RARP protocols.



Table C-1 on Table C-1 lists the protocol suites that the LANplex supports,
as well as the protocol types included in each protocol suite.

Table C-1 Protocol Suite Protocol Types

Protocol Suite Protocol Types

IP IP, ARP, RARP

Novell IPX IPX

AppleTalk DDP, AARP

Xerox XNS XNS IDP, XNS Address
Translation, XNS Compatibility

DECnet DEC MOP, DEC Phase IV, DEC LAT,
DEC LAVC

SNA SNA Services over Ethernet

Banyan VINES Banyan

X25 X.25 Layer 3

NetBIOS NetBIOS

NetBEUI | NetBEU |

Default Default (all protocol types)
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ATM

AAL

Backbone

Broadcast

Bridge

BUS

Cell
Connection-oriented
Communications
ELAN

Ethernet

Ethernet Port

GLOSSARY

Asynchronous Transfer Mode. A transmission protocol that segments
user traffic into small, fixed size cells. Cells are transmitted to their
destination, where the original traffic is re-assembled.

ATM Adaptation Layer. A set of protocols that translate user traffic
from higher-layer protocols into ATM format.

The main segment of a campus network, to which are attached
department networks, or ribs.

A common method of information transmission in which every port on
the network receives the packet being sent, though only the port with
the proper address passes it on to the user.

Device connecting between two networks which filters and forwards
data between the networks according to their destination address.

Broadcast and Unknown Server. ATM Forum defined specifications in
support of LAN-to-LAN connectivity, called LAN Emulation. BUS defines
that set of functions implemented in an ATM Network that provides
LAN-to-LAN transmission support while a LAN connection is being
established. It also supports LAN broadcast service.

An ATM Layer protocol data unit (PDU) characterized by fixed, rather
than variable, length payloads.

A form of packet-switching that requires a predefined circuit from
source to destination to be established before data can be transferred.

Emulated LAN - Set of ATM Forum-developed specifications in support
of LAN-to-LAN bridged connectivity over an ATM Network.

A CSMA/CD, 10 Mbps, local area data network, developed by Xerox
Corporation. It is one of the most popular baseband LANSs in use.

A port of a LinkSwitch to which an Ethernet Segment is connected.
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Ethernet Segment

IP

IP Address
LAN

LEC

LES

LECS

LE ARP

MIB

NNI

A group of end-users connected by Ethernet that is connected to a
port of a LinkSwitch.

Internet Protocol. The protocol governing packet forwarding within the
Transmission Control Protocol/Internet Protocol (TCP/IP) suite of
standards developed and used on the Internet.

Internet Protocol address. A unique identifier for a machine attached to
a network made up of two or more interconnected local area or wide
area networks.

Local Area Network. A data communications network spanning a
limited geographical area, such as a single building or campus. It
provides communication between computers and peripherals. LANs are
distinguished by their small geographical size, high data rate, and low
error rate.

LAN Emulation Client. ATM Forum defined specifications in support of
LAN-to-LAN connectivity. called LAN Emulation. LEC defines that set of
functions implemented in a LAN edge device (DTE) to interface with an
ATM Network in support of LAN Emulation.

LAN Emulation Server. ATM Forum defined specifications in support of
LAN-to-LAN connectivity, called LAN Emulation. LES defines that set of
functions implemented in an ATM Network in support of LAN
Emulation.

LAN Emulation Configuration Server. ATM Forum defined specifications
in support of LAN-to-LAN connectivity, called LAN Emulation. LECS
defines that set of functions implemented in an ATM Network that
provides edge device with information regarding the location of the
other LAN Emulation Services.

LAN Emulation Address Resolution Protocol. The LE ARP is a request for
address resolution from a LE Client to the network in order to get an
ATM address of another client for connection establishment.

Management Information Base. A database of network management
information that describes the specifics of individual network
components.

Network-to-Network Interface. The interface between two network
nodes. The NNI is a protocol that allows connection between ATM
switches to form a multiple switch network.



Network
Management
Platform (NMP)

Network
Management Station

Network
Management System
(NMS)

P-NNI

PVC

SmartAgent

SNMP

SvC

UNI

VCI

VPI

VLAN

Window-based data-base tool for Network Management, e.g., SunNet
Manager, HP OpenView, NetView/6000

Workstation from which the Network is managed using the Network
Management System

Application of Network Management Platform for a specific Network.
Runs on the Network Management Station.

Private Network-Node Interface. Set of ATM Forum developed
specifications for the interface between two ATM nodes in the same
network.

Permanent Virtual Channel. A virtual channel connection that has been
established manually, in advance of its need.

Software embedded in LinkSwitch or CELLplex units which
communicates with and passes device information to the Network
Management System.

Simple Network Management Protocol. A protocol originally designed
to be used in managing TCP/IP internets. SNMP is presently
implemented on a wide variety of computers and networking
equipment and may be used to manage many aspects of network and
end-station operation. The standard protocol used by the ATM
Manager to request management data from a managed device.

Switched Virtual Channel. A virtual channel connection that has been
established.

User-Network Interface. ATM Forum developed specification for the
procedures and protocol between a user equipment and the ATM
Network to effectively utilize ATM services and capabilities.

Virtual Channel Identifier. Part of the identifier of a particular virtual
circuit in the ATM fabric.

Virtual Path Identifier. Part of the identifier of a particular virtual circuit
in the ATM fabric.

Virtual LAN. A network configuration in which users communicate
using LAN protocols as if they were on the same physical LAN, but in
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VPI
VCI

VC

TEM UNIX
TEM Windows

ul

fact they are on physically separate segments. A virtual LAN acts as a
broadcast domain.

Virtual Path Identifier. A field in a cell header which identifies the
specific virtual path on which the cell is traversing on the current
physical circuit.

Virtual Channel Identifier. A field in a cell header which identifies the
specific virtual channel on which the cell is traversing on the current
physical circuit.

Virtual Channel. Each physical circuit in an ATM Network is
pre-configured with some number of virtual paths. Each virtual path
may support many virtual channels. Neither VPs or VCs are assigned
any dedicated bandwidth.

Transcend Enterprise Manager for UNIX.
Transcend Enterprise Manager for Windows

User Interface
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